MR 816_{csx}
MR 816_{x}
ADVANCED INTEGRATION DSP STUDIO
Introduction

Thank you for purchasing the ADVANCED INTEGRATION DSP STUDIO MR816 CSX/MR816 X. This comprehensive audio interface allows you to transfer the sound of your instruments (keyboards, guitars, microphones) to the DAW software (such as Cubase) on your computer, as well as process and monitor the DAW sound — all through a single IEEE1394 cable. Moreover, the sophisticated Link function provides seamless operation and convenient studio-like monitoring options. The MR816 CSX/MR816 X comes with two manuals: “Getting Started” (printed booklet) and “Operation Manual” (this PDF document). The Getting Started manual provides basic instructions on setting up, installing required software, making connections, recording to your computer and so on. This Operation Manual is a comprehensive, detailed guide to the functions and features of the device. Please read the Getting Started manual first, followed by this manual, in order to get the most out of the device and enjoy trouble-free operation for years to come.

Main Features

**Link with Cubase**
Install the included software and you can link the MR816 CSX/MR816 X with Cubase for seamless operation — for example, monitoring the Cubase-mixed sound with no latency, and one-button-press assignment of audio inputs to Cubase tracks. Flagship model of Cubase can also use the convenient Control Room feature with the MR816. For details about the Link function, refer to page 9.

**High-quality sound**
The MR816 CSX/MR816 X is equipped with eight discrete head amplifiers using the Inverted Darlington Circuitry Design, for superior, highly musical sound with minimal distortion and noise.

**Mixer function and useful monitoring**
The mixer function (with DSP processor) lets you input up to sixteen channels of audio and mix down to eight channels of stereo. Two of these stereo outputs can be assigned for separate monitoring through headphones connected to the PHONE jacks on the front panel. What’s more, the monitor sound can be processed with the REV-X reverb effect, allowing you to have a full and natural monitor sound without latency delays.

**Versatile input/output jacks for professional studio use**
The MR816 CSX/MR816 X is equipped with eight mono input jacks (MIC/LINE/Hi-Z jack and MIC/LINE jack on the front panel and MIC/LINE/INPUT jacks on the rear panel) which accept both XLR-3-31 and TRS phone plug type connectors. In addition, each of these jacks provides a [PAD] button which enables connection of a wide range of instruments and devices—from condenser microphones to synthesizers and other line-level instruments. The MIC/LINE/Hi-Z jack is compatible with Hi-Z (high impedance) inputs, allowing you to connect instruments with high output impedance, such as electric guitar or bass. The MIC/LINE/Hi-Z jack and MIC/LINE jack are routed to the INSERT I/O jacks on the rear panel, letting you apply a desired effect (different from the internal one) to the sound already input from the external device. Furthermore, the WCL (Word Clock) jack and the digital jacks are also provided for comprehensive compatibility with devices and applications in professional studios.

**REV-X effect**
The MR816 CSX/MR816 X is equipped with the REV-X Effect, a high-quality digital reverb effect unit which can be applied to all input channels. When connecting the MR816 CSX/MR816 X to a computer, this reverb can be applied to the input signal coming from the DAW software as well as the sound from audio equipment such as keyboards, guitars and microphones. In addition, a dedicated window lets you create more detailed settings for this effect unit.

**Sweet Spot Morphing Channel Strip effect (MR816 CSX only)**
The MR816 CSX is equipped with eight independent blocks of the Sweet Spot Morphing Channel Strip effect using the new Sweet Spot Morphing Technology developed by Yamaha. These give you a variety of specially programmed compressor/ equalizer settings into which are distilled years of extensive professional engineering experience, letting you quickly and easily achieve professional-level results for your sound by simple panel operations. When connecting the MR816 CSX to a computer, this effect can be applied to the audio signal transferred/recorded to the DAW software (such as Cubase) as well as the sound from audio equipment such as keyboards, guitars and microphones. In addition, a dedicated window lets you create more detailed settings for this effect unit.

**Daisy-chain connection of up to three devices**
Up to three MR816 CSX/MR816 Xs (two devices when the Sample Rate is set to 88.2 kHz or 96 kHz) can be connected in daisy-chain fashion. You can expand the input/output channels simply by connecting the MR816 CSX/MR816 X additionally to the existing device via an IEEE1394 cable.
# Table of Contents

## Introduction ................................... 2

## Main Features ...................................... 2

## The Controls and Connectors ................. 4

- Front Panel ........................................... 4
- Rear Panel ............................................. 7

## Internal Structure of the MR816 CSX/MR816 X ............... 8

## Using the MR816 CSX/MR816 X with Cubase ...................... 9

- What you can do using the MR816 CSX/MR816 X with Cubase ................. 9
- Start your recording session! .................................. 10
  - Connections ........................................... 10
  - Setting up on the computer ............................... 11
  - Setting up for recording ................................ 13
  - Try recording .......................................... 18
- Using the built-in effect of the MR816 as a VST plug-in of Cubase ............. 19

## Dedicated windows for the MR816 CSX/MR816 X in Cubase 21

- MR816 CSX/MR816 X Input Settings window .................. 21
  - How to call up the window ............................... 21
  - Parameter functions .................................... 22
- MR816 CSX/MR816 X Hardware Setup window .................. 23
  - How to call up the window ............................... 23
  - Parameter functions .................................... 23
- REV-X .................................................... 25
  - How to call up the window ............................... 25
  - Parameter functions .................................... 25
- Sweet Spot Morphing Channel Strip (MR816 CSX only) 27
  - How to call up the window ............................... 27
  - Parameter functions .................................... 28
- Control Panel ........................................... 30
  - How to call up the window ............................... 30
  - Parameter functions .................................... 30

## MR Editor ........................................... 33

- Main window ............................................ 33
- Setup window .......................................... 41

## Using a DAW other than Cubase .................. 42

## Using multiple MR816 CSX/MR816 Xs .................. 43

## Using the MR816 CSX/MR816 X without a computer .......... 44

## Appendix .............................................. 45

- Hints when using audio data (Windows) ...................... 45
- Troubleshooting ......................................... 46
- Specifications ........................................... 48
- Error Messages ........................................... 49
- Block Diagrams .......................................... 50
  - MR816 X .................................................. 50
  - MR816 CSX ............................................. 52

## Special Notice

- This manual is the exclusive copyrights of Yamaha Corporation.
- The screen displays as illustrated in this manual are for instructional purposes, and may appear somewhat different from the screens which appear on your computer.
- This product incorporates and bundles computer programs and contents in which Steinberg Media Technologies GmbH and Yamaha Corporation own copyrights or with respect to which it has license to use others' copyrights. Such copyrighted materials include, without limitation, all computer software, style files, MIDI files, WAVE data, musical scores and sound recordings. Any unauthorized use of such programs and contents outside of personal use is not permitted under relevant laws. Any violation of copyright has legal consequences. DON'T MAKE, DISTRIBUTE OR USE ILLEGAL COPIES.
- Copying of the commercially available musical data including but not limited to MIDI data and/or audio data is strictly prohibited except for your personal use.
- Steinberg and Cubase are the registered trademarks of Steinberg Media Technologies GmbH.
- Windows is a registered trademark of Microsoft® Corporation in the United States and other countries.
- Apple, Mac and Macintosh are trademarks of Apple Inc., registered in the U.S. and other countries.
- FireWire and the FireWire symbol are trademarks of Apple Inc., registered in the U.S. and other countries. The FireWire logo is a trademark of Apple Inc.
- ADAT is a trademark of Alesis registered in U.S. and other countries.
- The company names and product names in this manual are the trademarks or registered trademarks of their respective companies.
The Controls and Connectors

This section provides an overview of the panel controls and connectors of the MR816 CSX/MR816 X.

Front Panel

1 **[HI-Z]** switch
This switch enables use of a high-impedance instrument (electric guitar, bass, etc.) connected to the MIC/LINE/Hi-Z jack (audio input jack) at the right of this switch. When directly connecting an electric guitar or electric bass that has passive pickups and no built-in preamp to the MIC/LINE/Hi-Z jack, set the [HI-Z] switch to the upper position.

**NOTE**
- Use an unbalanced phone cable when you connect an electric guitar or bass and set the [HI-Z] switch to the upper position. If you use a balanced cable or an XLR cable in such a case, this instrument will not work correctly.

2 **MIC/LINE/Hi-Z jack (Analog input jack 1) and MIC/LINE jack (Analog input jack 2)**
These mono channel input jacks (Nominal Level: -60dBu – +10dBu) that support both balanced and unbalanced signals are used to connect microphones or musical instruments. These balanced input jacks accept both XLR-3-31 and TRS phone plug type connectors. Audio signals input via these jacks will be routed through the analog input channels of a computer and analog/digital output jacks. The wiring configuration for these jacks is as shown below.

- **Male XLR**

  ![Male XLR Wiring](image)

  - 1 (ground)
  - 2 (hot)
  - 3 (cold)

- **TRS phone**

  ![TRS Phone Wiring](image)

  - Tip (hot)
  - Ring (cold)
  - Sleeve (ground)

  Note that the MIC/LINE/Hi-Z jack is equipped with a [HI-Z] switch (1) to accept a high-impedance instrument (electric guitar, bass, etc.).

3 **[QUICK CONNECT]** buttons (with LED lamps)
These buttons enable assignment of the analog input jacks (MIC/LINE/Hi-Z jack labeled “1” on the front panel, MIC/LINE jack labeled “2” on the front panel and MIC/LINE INPUT jacks labeled “3” – “8” on the rear panel) to the input bus of audio tracks on Cubase. By selecting an audio track or audio tracks on Cubase (on a connected computer) then pressing any of these buttons, you can have the audio signal input via the corresponding jack sent to the selected track on Cubase. The [QUICK CONNECT] lamps to which audio tracks of Cubase are assigned will light. If you select an audio track already assigned to one of the analog input jacks, the lamp of the corresponding number flashes.

4 **[SIG/PEAK]** lamps
These lamps indicate the current status of audio input signals from the analog input jacks (MIC/LINE/Hi-Z jack labeled “1” on the front panel, MIC/LINE jack labeled “2” on the front panel and MIC/LINE INPUT jacks labeled “3” – “8” on the rear panel), respectively. The lamp lights as follows depending on the strength of the input signals.

<table>
<thead>
<tr>
<th>Level</th>
<th>Lamp Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>-40dB or less (including no input signals):</td>
<td>Off</td>
</tr>
<tr>
<td>-40dB – -3dB:</td>
<td>Green</td>
</tr>
<tr>
<td>-3dB or more:</td>
<td>Red</td>
</tr>
</tbody>
</table>

When the [PAD] lamp is turned on: -60dB – -16dB
When the [PAD] lamp is turned off: -34dB – +10dB

5 **Gain knobs 1 – 8**
These knobs enable you to attenuate/boost the level of the audio input signal from the analog input jacks (MIC/LINE/Hi-Z jack labeled “1” on the front panel, MIC/LINE jack labeled “2” on the front panel and MIC/LINE INPUT jacks labeled “3” – “8” on the rear panel), respectively. The adjustable range on each channel varies depending on the on/off status of the [PAD] button (3).

![Gain Knob Range](image)
[+]48V button (Phantom power button)

This button enables you to toggle on and off phantom power, which is necessary for condenser microphones. By holding this button and pressing one of the [QUICK CONNECT] buttons 1 – 8, you can apply phantom power to the analog input jack corresponding to the pressed button. Performing the same operation removes phantom power. The [+48V] button is turned on when phantom power is applied to one or more of the input jacks, while the [+48V] button will be turned off when phantom power is off for all the input jacks. Holding this button will turn on the [QUICK CONNECT] lamp(s) corresponding to the channel number(s) to which phantom power is applied.

**CAUTION**
- To avoid damage to your hearing or speakers, be sure to roll off the volume level of the amplifier (or powered speakers) before turning phantom power on or off. Steinberg/Yamaha also recommends that you turn all output levels to minimum settings before operating this button.
- Be sure to leave the phantom power off if you do not need it.
- When turning phantom power on, make sure that only condenser microphones are connected to the corresponding input jacks. Devices other than condenser microphones may be damaged if they are connected to the phantom power supply. Note, however, that phantom power may be left on when you connect balanced dynamic microphones.
- If you connect a device that requires an external power supply, first connect the device to an Input jack, then turn on the phantom power. If you disconnect the device, make sure to turn off the phantom power before disconnecting the device.

[+PAD] button

This switch toggles the Pad on and off. Holding this button and simultaneously pressing one of the [QUICK CONNECT] buttons lets you toggle the Pad of the corresponding input jack on and off. The audio input signal from an input jack for which Pad is turned on is attenuated by 26 dB. Therefore, you should turn Pad off if you have connected equipment of low output level (a microphone or other mic-level device), while Pad should be on for equipment of high output level (a synthesizer keyboard, CD player, etc.). This button will be turned on when the Pad of one or more input jacks is turned on, and will be turned off when Pad is off for all input jacks. Holding this button will turn on the [QUICK CONNECT] lamp(s) corresponding to the channel number(s) for which Pad is turned on.

ASSIGN lamps

These lamps indicate the current function assigned to the Multi Function Encoder Knob 1 and 2. For information about assignable functions, refer to (1).

**NOTE**
- The [MORPH] lamp is available only for the MR816 CSX. The MR816 X is not equipped with the [MORPH] lamp.
The Controls and Connectors

1 Multi Function Encoder Knobs 1 and 2
Rotating and pressing these knobs lets you select and adjust various parameters, such as output level from the headphone jack, master volume, and reverb related parameters. Rotating each of these knobs adjusts the parameter value while pressing the knobs changes the assigned functions. The lamps around each knob indicate the current value of the currently edited parameter. The ASSIGN lamps (●) indicate the current function assigned to the Multi Function Encoder knobs.

<table>
<thead>
<tr>
<th>ASSIGN lamp</th>
<th>Knob 1</th>
<th>Knob 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>PHONES</td>
<td>Adjusts the volume level output from the headphone jack (●) 1 on the front panel.</td>
<td>Adjusts the volume level output from the headphone jack (●) 2 on the front panel.</td>
</tr>
<tr>
<td>MASTER</td>
<td>Adjusts the master volume level output from the OUTPUT 1 – 8 jacks on the rear panel.</td>
<td>Adjusts the master volume level output from the S/PDIF OUT jack and OPTICAL OUT jack on the rear panel.</td>
</tr>
<tr>
<td>REV-X</td>
<td>Adjusts the reverb time of the internal Reverb effect unit (REV-X).</td>
<td>Adjusts the return level from the internal Reverb effect unit.</td>
</tr>
<tr>
<td>MORPH*</td>
<td>Adjusts the DRIVE parameter of the internal compressor.</td>
<td>Morphs the Sweet Spot Data of the internal compressor.</td>
</tr>
</tbody>
</table>

* Only available on the MR816 CSX.

NOTE
- When the MORPH lamp is lit, select the input channel to be edited by pressing the [QUICK CONNECT] button. For details, see page 4.
- Pressing either of the encoder knobs will automatically change the function assignment.
- When the MORPH lamp is turned on, each of the end lamps around the Multi Function Encoder knob 2 (right side) will not light even if you turn the Knob 2 all the way toward the left or right. This is normal.

2 Headphone jacks (●) 1 and 2
These two 1/4" TRS phone output jacks are used for connecting headphones. The levels of these jacks can be adjusted independently by using the Multi Function Encoder knobs (●). By setting the related parameters in Cubase or the MR Editor, you can set up custom monitor mixes for the musicians you’re recording. For details, refer to pages 22 and 39.

3 STANDBY/ON switch
This switch sets the power to ON or STANDBY.

TIP
Word Clock
In a typical digital audio system, the signal referred to as “word clock” is used to synchronize the process timing of audio signals between the multiple devices. When transferring audio data between the master recorder and the MR816 CSX/MR816 X via the S/PDIF jacks or OPTICAL jacks, the MR816 CSX/MR816 X will handle the audio data according to the word clock transmitted from the master recorder. If the word clock is not transferred correctly, click noise may occur or recording may not be successful. Normally, one device transmits a reference word clock signal, and the other devices receive this word clock signal and synchronize to it. The transmitting device is called the “word clock master” and the receiving devices are called “word clock slaves.” On the MR816 CSX/MR816 X, the word clock can be transferred via either the WCLK (Word Clock) jack, the S/PDIF jack or the OPTICAL jack.

Because some digital equipment can operate only as the word clock master or slave, you may need to set the word clock source on the MR816 CSX/MR816 X. If such a device is connected to the MR816 CSX, make sure to set the Word Clock Source parameter on the Control Panel of Yamaha Steinberg FW Driver or the MR Editor on the computer.

When using the MR816 CSX/MR816 X as the word clock master, set the Word Clock Source parameter to “INTERNAL.” When using the MR816 CSX/MR816 X as the word clock slave, set the Word Clock Source parameter to “ADAT” or “S/PDIF” or “WCLK In” then set the Sample Rate to the same value as that of the master device.
Rear Panel

1 AC ADAPTOR IN jack
Connect an AC power adaptor here (refer to the “Getting Started” manual included in the package).

2 S/PDIF IN/OUT jack (Digital input/output jack)
These coaxial jacks (RCA pin connectors) input and output S/PDIF format (IEC-60958) digital audio signals. By plugging the coaxial (RCA-pin) cable to this jack, you can connect the MR816 CSX/MR816 X an external digital audio device such as a master recorder.

3 OPTICAL IN/OUT jack (Digital input/output jack)
These jacks input and output S/PDIF or ADAT digital audio signals. By plugging the optical-fiber cable to this jack, you can connect the MR816 CSX/MR816 X an external digital audio device such as a hard disk recorder, MD player or CD player. Selection of S/PDIF or ADAT can be set from the MR Editor (page 33) or the Control Panel of the Yamaha FW Driver (page 30).

4 IEEE1394 jacks 1 and 2
These 6-pin IEEE1394 (S400) standard jacks enable connection of an IEEE1394-compatible computer and another MR816 CSX/MR816 X. The operation is identical regardless of which jack is used (1 or 2). You can use one of them to connect a computer, and the other jack for another MR816 CSX/MR816 X (or a device compatible with the Yamaha Steinberg FW Driver) for daisy-chain connection. If your computer has a 4-pin IEEE1394 jack, use a 4-pin to 6-pin type IEEE1394 cable that meets the S400 specifications.

**CAUTION**
- Be sure to connect the IEEE1394 cable plug to the IEEE1394 jack with the correct orientation.

**NOTE**
- Use an IEEE1394 cable that meets the S400 standard. Steinberg/Yamaha recommends that you use an IEEE1394 cable with a length of 4.5 meters or less.
- Connect your IEEE1394 cables so that they do not create a loop. For information about loop connections, refer to page 47.

5 WCLK IN/OUT jack (Word Clock in/out jack)
These are BNC jacks used to input and output word clock signals to and from to an external device.

6 OUTPUT jacks 1 – 8 (Analog output jacks 1 – 8)
These are mono output jacks (TRS phone type) that support both balanced and unbalanced signals. The nominal signal level is +4dBu.

7 MIC/LINE INPUT jacks 3 – 8 (Analog input jacks 3 – 8)
These mono channel input jacks (XLR/TRS phone) that support both balanced and unbalanced signals are used to connect microphones or musical instruments. The nominal signal level is -60dBu – +10dBu. Connector wiring is as shown in the section on page 4.

8 INSERT I/O jacks 1 and 2
These phone-type unbalanced I/O jacks can be used to connect external effect units or another device for processing the audio signals already input to the MR816 CSX/MR816 X via the MIC/LINE/HI-Z jack (analog input jack 1) and MIC/LINE jack (analog input jack 2) respectively. In the internal circuitry, these jacks are positioned immediately before the A/D converters (included in the MR816 CSX/MR816 X). The audio signal input via the MIC/LINE/HI-Z jack will be transferred to the effect unit or other device connected to INSERT I/O jack 1 then returned to INSERT I/O jack 1. Likewise, the audio signal input via the MIC/LINE jack will be transferred to the effect unit or other device connected to INSERT I/O jack 2 then returned to INSERT I/O jack 2.

Connection to an INSERT I/O jack requires a special insertion cable as illustrated below.
Internal Structure of the MR816 CSX/MR816 X

The MR816 CSX/MR816 X is equipped with a digital mixer supported by DSP technology. This mixer lets you adjust various parameters, including volume and pan of the input signals for each output channel consisting of adjacent odd and even channels. Each stereo mix of the sound created with this operation will be output from the four analog outputs (OUTPUT jacks 1&2, 3&4, 5&6 and 7&8), the OPTICAL OUT jack and the S/PDIF OUT jack. If “ADAT” is selected as the output format of the digital audio, up to eight stereo outputs are available, including both analog and digital.

By creating a mix for the main output and a separate monitor mix for your musicians, for example, you can easily create a comprehensive, flexible monitoring environment – with no latency – for your recording session. Furthermore, using flagship model of Cubase lets you connect the Control Room function (of Cubase) and the internal mixer (of the MR816 CSX/MR816 X) seamlessly, giving you a versatile monitoring environment.

When the MR816 CSX/MR816 X is connected to your computer, the signals coming to the input channel of the internal mixer will be transferred to the DAW on the computer, returned from the DAW, mixed with other signals in the internal mixer then transferred to the corresponding output channel, as illustrated below.

The MR816 CSX/MR816 X is equipped with a special REV-X digital reverb unit which can be used as a Send Effect. The MR816 CSX, additionally, is equipped with a “Sweet Spot Morphing Channel Strip” (“Channel Strip” for short) which can be inserted to any of the analog input channels and digital input channels. These effect units can be inserted to different locations in the audio signal flow depending on the situation or usage.

NOTE
• For more detailed information about the internal structure, refer to the block diagrams at the end of this manual (pages 50 – 54).
Using the MR816 CSX/MR816 X with Cubase

This section features instructions on recording and mixing down via the Link function (using Cubase 5). Make sure to read “Turning the Power On and Off” and “Connecting to an External Device” in the Getting Started manual (printed booklet) before performing the operations explained below.

**NOTE**
- If using a version of Cubase other than version 5, see the PDF manual provided with the Cubase.

What you can do using the MR816 CSX/MR816 X with Cubase

Linking the MR816 CSX/MR816 X to Cubase enables the following operations.

**NOTE**
- In order to use the Link function between the MR816 CSX/MR816 X and Cubase, you will need to install Cubase 5 or later, which is compatible with the Link function (including Cubase AI). For the most recent information on Cubase versions compatible with the Link function, refer to the following website.
  http://service.steinberg.de/goto.nsf/show/supportupdates_mr816_gb/
- To take the full advantage of the MR816 CSX/MR816 X's functions, you should use flagship model of Cubase.

- **Quickly routing the input channel to an audio track of Cubase**
The Quick Connect feature lets you assign the hardware input signal to the Cubase audio track with a single touch. Simply select an audio track or tracks on Cubase then press the desired [QUICK CONNECT] button, and all settings for routing are automatically completed. This quick and easy operation streamlines the recording process, and lets you concentrate on creating and recording while the track assign details are taken care of for you. After you’ve set the audio routing, selecting the audio track to which the input channel is assigned will cause the corresponding lamp to flash, allowing you to confirm the routing status easily. For detailed instructions refer to page 13.

- **Monitor Mix linked with the Control Room function (only for Cubase)**
When you use flagship model of Cubase, the Control Room function can be linked with the MR816 CSX/MR816 X, allowing you to mix the monitor sound. The sound for recording musicians as well as the main mix sound can be heard without latency since Cubase is directly linked to the internal mixer of the MR816 CSX/MR816 X. For details, refer to page 14.

- **Controlling mixing parameters by using dedicated windows in Cubase**
Dedicated windows specially designed for the MR816 CSX/MR816 X let you control the internal mixer and effects from Cubase. The settings made in Cubase can be saved as a project file, letting you quickly recall the entire settings made in the previous session. For details about the dedicated windows, refer to page 21.

- **Controlling the REV-X effect for monitoring purposes**
The REV-X effect unit (built both in the MR816 CSX and MR816 X) can be controlled easily from Cubase. While this effect can be used normally as a Send Effect, it can also be used as a plug-in effect by setting the MR816 CSX/MR816 X to the external effect mode. For details, refer to page 25.

- **Controlling the Channel Strip (MR816 CSX only)**
The built-in Sweet Spot Morphing Channel Strip (MR816 CSX only) can be controlled from Cubase. This effect is normally applied to the Input Channels as an Insertion Effect, though it can also be used as a plug-in effect by setting the MR816 CSX to the external effect mode. For details, refer to page 27.

**NOTE**
- The functions listed above (except for “Quickly routing the input channel to an audio track of Cubase”) are available only when Direct Monitoring is turned on.
Start your recording session!

In this section, you’ll learn how to transfer the input channel signals of the MR816 CSX/MR816 X to Cubase then record them on the audio tracks.

Connections

First, you’ll need to connect the sources you’ll be recording (your musical instruments, microphones, etc.) to the input jacks, and connect the monitor devices (speakers or headphones) to the output jacks or headphone jacks, then turn all the devices on.

1. Connect external devices to the MR816 CSX/MR816 X then connect your computer to the MR816 CSX/MR816 X via an IEEE1394 cable. For details, refer to the Getting Started manual (printed booklet included in this product).

WARNING
- Before connecting the instrument to other electronic components, turn off the power of all the components. Also, before turning any components on or off, make sure to set all volume levels to minimum (0). Otherwise, electrical shock or damage to the components may occur.

2. Turn on the every device in the following order: 1) the connected microphones/musical instruments, 2) the MR816 CSX/MR816 X, and 3) the monitor speakers.

3. Turn down the volume of the master output and headphones to prevent any loud, unexpected sound.
   - Turning the master volume
   Press the encoder knob a few times so that the MASTER lamp lights, then rotate the encoder knob counter-clockwise to turn down the master volume (of the audio from the OUTPUT jacks 1 – 8, S/PDIF OUT jack and OPTICAL OUT jack on the rear panel).
   - Turning down the volume of the headphones
   Press the encoder knob a few times so that the PHONES lamp lights, then rotate the encoder knob counter-clockwise to turn down the volume of the audio signals output from the headphone jacks on the front panel.

4. If necessary, turn phantom power [+48V] on/off then turn the [PAD] on/off.
   - Turning phantom power on/off
   To turn phantom power on, hold the [+48V] button then press the [QUICK CONNECT] button corresponding to the analog input jack to which the condenser microphone is connected. While holding the [+48V] button, you can turn phantom power on or off for other analog input jacks (1 – 8) individually by pressing the corresponding [QUICK CONNECT] button. The [QUICK CONNECT] buttons of analog input jacks to which phantom power is applied will light while holding the [+48V] button. The [+48V] button will light when phantom power is on for any of the analog input jacks.

   - Turning the [PAD] on/off
   To do this, hold the [PAD] button then press the [QUICK CONNECT] button corresponding to the analog input jack which you want to apply the Pad. Pad reduces the level for the corresponding input by a certain amount. While holding the [PAD] button, you can turn Pad on or off for other analog input jacks (1 – 8) individually by pressing the corresponding [QUICK CONNECT] button. The [QUICK CONNECT] button of the analog input jacks to which Pad is applied will light while holding the [PAD] button. The [PAD] button will light when the Pad is turned on for any of the analog input jacks.

NOTE
- When turning the power off, follow the opposite order (monitor speakers → MR816 CSX/MR816 X → microphone/musical instrument) after turning all volume settings down all the way to the minimum.

CAUTION
- When disconnecting/connecting cables after the setup is completed, make sure to turn all volume settings down all the way to the minimum.

NOTE
- If the phantom power or PAD of any analog input channel is turned on, the corresponding [QUICK CONNECT] buttons are turned on only when the [+48V] or [PAD] button is pressed.
CAUTION

- To avoid damage to your hearing or speakers, be sure to roll off the volume level of the amplifier (or powered speakers) before turning the phantom power on or off. Steinberg/Yamaha also recommends that you turn all output levels to minimum settings before operating this button.
- Be sure to leave the phantom power off if you do not need it.
- When turning the phantom power on, make sure that only condenser microphones are connected to the corresponding input jacks. Devices other than condenser microphones may be damaged if they are connected to the phantom power supply. Note, however, that the phantom power may be left on when you connect balanced dynamic microphones.
- If you connect a device that requires an external power supply, first connect the device to an Input jack, then turn on the phantom power. If you disconnect the device, make sure to turn off the phantom power before disconnecting the device.

Setting up on the computer

Follow the steps below to set up your computer for using the Link function with Cubase.

NOTE

- Before using the Cubase Link function, make sure to install TOOLS for MR then make initial settings. For more information about installation procedures and initial settings for the TOOLS for MR, please refer to the Getting Started manual (printed manual).

1 Start the computer.
   Wait until the Word Clock Source lamps and Sample Rate lamps finish flashing successively.

NOTE

- Note that the Clock Source lamps and Sampling Rate lamps flash while Yamaha Steinberg FW Driver is performing setup of the MR816 CSX/MR816 X. These lamps continue flashing if the setup is not completed properly.

2 Start Cubase.

   For Windows:
   Click [Start] → [All Program] → [Steinberg Cubase 5] → [Cubase 5] to start the program.

   For Mac:
   Double-click [Applications] → [Cubase 5] to start the program.
   If the following dialog appears while Cubase is starting, click [OK].

3 When the Project Assistant window appears, click [Recording].
   The Project templates for the MR816 CSX/MR816 X will be shown if the TOOLS for MR has already been installed. Selecting any of these templates will automatically set the routing of the audio input/output.
4 Select the desired template then click [Create]/[Continue].

On the front panel of the MR816 CSX/MR816 X, the [QUICK CONNECT] lamps to which audio tracks of Cubase are assigned will light.

5 Select [Devices] → [Device Setup...] to call up the Device Setup window. Select “VST Audio System” in the Device column then confirm whether or not “Yamaha Steinberg FW ASIO”/“Yamaha Steinberg FW” is selected from the ASIO Driver column.

If it is selected, click [OK] to close the window. The MR816 CSX/MR816 X can now be linked to Cubase.

NOTE
• When changing the ASIO driver, a dialog box may appear asking “Do you want to switch the ASIO driver?”. Click [Switch].

6 On the Device field, select “Yamaha Steinberg FW ASIO” or “Yamaha Steinberg FW,” make sure that the checkbox of “Direct Monitoring” is turned on, then click [OK] to close the window.

The settings on the computer have been completed.

TIP
If you want to change the Sample Rate or routing of the input/output bus, follow the instructions below.

● To change the Sample Rate:
Select [Project] → [Project Setup] to call up the Project Setup dialog.
After setting, click [OK] to close the dialog. According to the setting made here, the Sample Rate of the MR816 CSX/MR816 X will be changed automatically.

● To change the routing of the input/output bus:
Select [Devices] → [VST Connections] to call up the VST Connections window. From this window, you can change the device port of the existing bus and add the new bus.

NOTE
• If the Direct Monitoring is turned on, you can monitor the Cubase-mixed sound with no latency. Since the MR816 CSX/MR816 X is equipped with the effect unit, you can monitor the effect-applied signal even when the Direct Monitoring is turned on. Furthermore, you can use the Direct Monitoring function in the Studio Send also when you use the Control Room function. It is recommended to turn the Direct Monitoring on to take full advantage of the linked functions between the MR816 CSX/MR816 X and Cubase.
Setting up for recording

Setting up an Audio Track

In the Project created via the project template for the MR816 CSX/MR816 X, the input bus corresponding to the analog input jack of the MR816 CSX/MR816 X is assigned to the input source of each audio track. This means that you can simply open the desired Project template and immediately be ready to record. If you want to change the input source of the audio track, simply use the [QUICK CONNECT] button to change the routing between the analog input jack and audio track.

The instructions below show how to assign the signal of analog input jack 4 to audio track 1, using an example in which “Steinberg MR816CSX multi channel recording” or “Steinberg MR816X multi channel recording” is selected as a Project template. This operation described below basically applies also when selecting other audio tracks.

1 When you want to change the assignment of the input signal within a Project, select the desired audio track.

If you select an audio track already assigned to one of the analog input jacks, the lamp of the corresponding number will flash for a while instead of being lit continuously. In the setting example above, the [QUICK CONNECT] lamp 1 will flash.

2 On the MR816 CSX/MR816 X, press the [QUICK CONNECT] button (corresponding to 4).

The [QUICK CONNECT] lamp 4 flashes for a while then lights. The [QUICK CONNECT] lamp 1 will turn off instead of being lit continuously, indicating that MIC/LINE INPUT jack 4 is assigned to the input bus of audio track 1.

Pressing the [QUICK CONNECT] button 1 while multiple audio tracks are selected will assign the bus to which the audio signal of analog input jack 1 is specified to all the selected tracks.

If desired, you can change the input jack assigned to the current track by pressing any other [QUICK CONNECT] button any time (except for during actual recording). For example, if microphone is connected to the MIC/LINE/Hi-Z jack (input channel 1) and a synthesizer is connected to the MIC/LINE jack (input channel 2), you can easily change the input source by pressing [QUICK CONNECT] buttons 1 or 2 alternately with the same audio track selected.

Automatic routing of the audio track via the [QUICK CONNECT] button

Pressing any of the [QUICK CONNECT] buttons with a certain audio track(s) selected will assign the audio signal of the corresponding input jack to the selected audio track(s) through the VST input bus. When the VST input bus is not set, the input bus will be created and assigned to the selected audio track automatically by pressing the [QUICK CONNECT] button. If you press one of the [QUICK CONNECT] buttons when the corresponding audio signal is specified to multiple buses, the bus created at the top line of the VST Connections window (called up via [Devices] → [VST Connections]) will be assigned to the selected track(s).
Using the MR816 CSX/MR816 X with Cubase

14

MR816csx / MR816x Operation Manual

When you select the audio track to which the audio signal of the analog input jacks 1 – 8 has been assigned (after making the assignments), the corresponding lamp(s) of the [QUICK CONNECT] buttons will flash for a while. This lets you confirm the audio routing assignment quickly. When you select multiple audio tracks, all the [QUICK CONNECT] lamps assigned to the selected tracks will flash simultaneously.

3 On Cubase, select the track to be recorded then turn on the Record Enable button and Monitor button.

4 While playing the instrument or singing into the microphone at the loudest expected level, gradually rotate the knob of the corresponding channel clockwise to find the point at which the corresponding [SIG/PEAK] flashes slightly in red.

In order to record the sound with the widest dynamic range and minimum noise, rotate the [GAIN] control clockwise to raise the input sensitivity as high as possible without the input signal clipping.

5 While playing the instrument or singing into the microphone, gradually adjust the volume of the master output and headphones.

The setup for recording has been completed.

NOTE

• To achieve a clear sound with the least noise, amplify the input to the desired average level as early as possible in the signal path. That means that you should amplify the input signal by using the corresponding knob as much as possible. Remember, however, that too much initial gain is bad, because it will cause clipping, and will distort the sound. Amplify the signal to a level just below clipping.

Adding multiple monitoring environments (only for Cubase)

The Control Room feature of flagship model of Cubase lets you seamlessly control the built-in mixer and create monitor mixes for the musicians. The actual mixing is performed in the MR816 CSX/MR816 X although the mix operation of Control Room is performed within Cubase, allowing you to create a latency-free monitor environment. Furthermore, two of the mix sounds created on the Control Room can be assigned independently to the two headphone jacks.

This section shows how to make the settings so that you can create monitor signals for vocals and guitar then output them from headphone jacks 1 and 2 respectively by using the Control Room feature. The settings explained below are useful if you want to record guitar and vocals simultaneously.

NOTE

• Keep in mind that the Control Room function is not available in Cubase AI. When you use Cubase AI, you can assign certain stereo output buses to headphone jacks 1 and 2 respectively.

1 Select [Devices] ➔ [VST Connections] to call up the VST Connections window.

2 Click the [Studio] tab on the top right of the VST Connections window then make sure that the Control Room function is available. If unavailable, click [Enable/Disable Control Room] to turn on the Control Room function.

3 Create the stereo Studios (up to four can be created) by clicking [Add Channel] then selecting [Add Studio].

NOTE

• The mono Studio cannot be selected as the output of the headphone jack.
4 For each of the created Studios, assign “Yamaha Steinberg FW ASIO” / “Yamaha Steinberg FW” to the Audio Device and assign your desired output jack to the Device Port.

5 Select [Devices] → [Control Room Mixer] to call up the Control Room Mixer window.

6 Turn on the output of channels [1] – [4] by clicking each of them, then make sure that the input of the corresponding channel is set to “AUX” (instead of “MIX”).

7 Select [Devices] → [Mixer] to call up the Extended Mixer window. If the Extended Mixer window is not shown, click the arrow (▲) button (“Show Extended View”) to call it up.

8 Call up the Studio Send on the Extended Mixer by clicking the “Show Studio Sends” button (▲) at the left on the window. The Studio Send lets you create custom mixes for the performer by specifying the level/pan/pre-fader/post-fader settings. You can create mixes also by using the fader/pan level of the main mix. In this case, you may need to make certain adjustments. For details, refer to the Cubase operation manual.

2. Turn the [AUX] on.

1. Turn on the Activate Channel buttons.
9 Call up the MR816 CSX/MR816 X Hardware Setup window (page 23) by selecting [Devices] ➔ [Audio Hardware Setup].

NOTE
• The MR816 CSX/MR816 X Hardware Setup window can be called up also from the MR816 CSX/MR816 X Input Settings window (page 21).

10 Click the monitor source of headphones 1 and 2, then select the desired output channels.

NOTE
• Also the Monitor Channel or Phone Channel can be selected as monitor source if they have been created.

11 Adjust the monitor level of the headphone jacks 1 and 2 as desired via the panel operation on the MR816 CSX/MR816 X or window operation on Cubase.

After making the settings, click [X] at the right top of the window to close it.

NOTE
• When the Control Room is not available or you use Cubase AI, you can assign the monitor source to the headphone jack by selecting one of the stereo output buses set in the VST Connection window.

Applying REV-X to the monitor signals

The REV-X effect unit built into the MR816 CSX/MR816 X is connected to the Send and Return of the internal mixer. Various parameters of this effect which can be applied only to the monitor sound will be adjusted for each of input channels on Cubase.

1 Select [Devices] ➔ [Mixer] to call up the Extended Mixer window.

If the Extended Mixer window is not shown, click the arrow ( ) button (“Show Extended View”) to call it up.

2 Call up the input channel mixer by clicking the Input Channel indication icon ( ) at the left of the Mixer window.

3 Make sure that MR816 CSX/MR816 X Input Settings window is shown on the Extended Mixer of the Input Channel’s mixer.

If the window is not shown, click the triangular ( ) button (“Extended View Type”) then select “Hardware” from the indicated menu.
4 Perform the following operations as required.

- To adjust the effect depth:
  Drag on the REV-X Send field below the REV icon and move the pointer leftward or rightward to adjust the send level.

- To adjust the effect parameters:
  Click the REV-X Edit ( ) to call up the REV-X Setup window. For information about the available parameters, refer to page 25.

- To adjust the effect type and return level:
  Click the REV-X Setup to call up the MR816 CSX/MR816 X Hardware Setup window. For information about the available parameters, refer to page 23.

The instructions below apply to Cubase.

1. Select [Devices] → [Mixer] to call up the Extended Mixer window.
   If the Extended Mixer window is not shown, click the arrow ( ) button (“Show Extended View”) to call it up.

2. Call up the input channel mixer by clicking the Input Channel indication icon ( ) at the left in the Mixer window.

3. Make sure that MR816 CSX/MR816 X Input Settings window is shown on the Extended Mixer of the Input Channel’s mixer.
   If the window is not shown, click the triangular ( ) button (“Extended View Type”) then select “Hardware” from the indicated menu.
4 Perform the following operations as required.
- To set the insertion location of the effect unit:
  Drag the slider for the effect insertion setup then select the desired one from the following items.

<table>
<thead>
<tr>
<th>Setting the slider</th>
<th>Effect Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upper position</td>
<td>Effect bypassed</td>
</tr>
<tr>
<td>Middle position</td>
<td>Effect applied only to monitor sound</td>
</tr>
<tr>
<td>Lower position</td>
<td>Effect applied to both monitor sound and signals to be recorded</td>
</tr>
</tbody>
</table>

NOTE
- For details about the insertion location, refer to page 22.
- To adjust the effect parameters:
  Click the Channel Strip Edit to call up the Channel Strip window. For information about the available parameters, refer to page 27.
- To adjust the MORPH and DRIVE:
  Drag the MORPH icon and DRIVE icon respectively then move the pointer.

NOTE
- For information about how to call up the above window when using Cubase AI, refer to page 21.

Try recording
Now that you’ve completed the necessary settings, try recording.

1 From the Transport window of Cubase, click the “Record” button to start recording.

2 Play the instrument connected to the MR816 CSX/MR816 X.

3 Click the “Stop” button after you’ve finished playing.

4 Move the pointer to the beginning of the project then click the “Start” button to hear the recorded sound.

- Note that the Channel Strip cannot be used for the monitor signal when the MR816 CSX/MR816 X is set to the external effect mode. In this case, the Channel Strip is not shown in the MR816 CSX/MR816 X Input Settings window.
Using the built-in effect of the MR816 as a VST plug-in of Cubase

You can use the built-in effect of the MR816 CSX/MR816 X as a VST plug-in effect within Cubase by setting the MR816 CSX/MR816 X to the external effect mode. The MR816 CSX lets you apply the Channel Strip effect to the eight mono channels or four stereo channels, or apply the Channel Strip effect to the six mono channels or three stereo channels and the REV-X effect to one stereo channel while the MR816 X lets you apply the REV-X effect to one stereo channel.

In the external effect mode, the digital input/output channels of the MR816 CSX/MR816 X function as effect buses exclusively for Cubase. In addition, the effect is applied to the digital input/output channels while being applied to the Send/Return of the internal mixer and input channels normally. Even when the MR816 CSX/MR816 X is set to the external effect mode, the analog input/output channels can be used.

Follow the instructions below to set the MR816 CSX/MR816 X to the external effect mode.

1. Select [Devices] \rightarrow [Device Setup...] to call up the Device Setup window.

   • You can also switch to external mode in the MR816 CSX/MR816 X Hardware Setup window (page 23), which is displayed by selecting [Devices] \rightarrow [Audio Hardware Setup].

2. In the Device field, select “Yamaha Steinberg FW ASIO”/”Yamaha Steinberg FW.”

3. Click [Control Panel]. For Mac users, also click [Open Config App]. The Control Panel of Yamaha Steinberg FW Driver appears.

4. Click the MR816 CSX tab or MR816 X tab. If you are connecting multiple devices, click the tab corresponding to the device you wish to set to the external effect mode.

5. Click the “Digital I/O, External FX” menu then select “External FX” from the pull-down menu. The MR816 CSX/MR816 X will be set to the external mode and the effect bus settings will be performed automatically.

6. When selecting the MR816 CSX in step 4, click “External FX Type” and select the desired item from the pull-down menu (as described below). When selecting the MR816 X in step 4, “External FX Type” does not appear.

   - **8 x Mono**
     - When this is selected, the Sweet Spot Morphing Channel Strip effect of up to 8 mono channels can be applied to the audio channels as a VST plug-in effect.
   - **4 x Stereo**
     - When this is selected, the Sweet Spot Morphing Channel Strip effect of up to 4 stereo channels can be applied to the audio channels as a plug-in effect.
   - **6 x Mono + REV-X**
     - When this is selected, the Sweet Spot Morphing Channel Strip effect of up to 6 mono channels and the REV-X effect (stereo) can be applied to the audio channels as plug-in effects.
   - **3 x Stereo + REV-X**
     - When this is selected, the Sweet Spot Morphing Channel Strip effect of up to 3 stereo channels and the REV-X effect (stereo) can be applied to the audio channels as plug-in effects.

After the setting is completed, click [X] at the right top of the window to close the Control Panel and Device Setup window.
7 Call up the Mixer window then make sure that the Extended Mixer window is shown.
If the Extended Mixer window is not shown, click the arrow button (“Show Extended View”) to call it up.

8 Click the “Show All Inserts” button at left in the Mixer window, then click the insertion slot of the audio channel.
The list of the VST plug-in effects will be shown on the insertion slot.

9 Select “MR816” from the indicated list then select the desired effect.
This operation will apply the internal effect to the audio track. For details about each value, see below.

<table>
<thead>
<tr>
<th>Channel Strip [m]:</th>
<th>Mono Channel Strip</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel Strip [s]:</td>
<td>Stereo Channel Strip</td>
</tr>
<tr>
<td>REV-X Hall:</td>
<td>REV-X with the Reverb type “Hall”</td>
</tr>
<tr>
<td>REV-X Room:</td>
<td>REV-X with the Reverb type “Room”</td>
</tr>
<tr>
<td>REV-X Plate:</td>
<td>REV-X with the Reverb type “Plate”</td>
</tr>
</tbody>
</table>

You can set the effect to the desired audio channels with this operation.

- The settings here, including those of the Control Panel, will be saved as a Project file of Cubase, allowing you to automatically recall the settings of the external effect mode and the plug-in effect settings the next time you open the Project.
- For information about the setting windows of each effect, refer to “REV-X” (page 25) or “Sweet Spot Morphing Channel Strip (MR816 CSX only)” (page 27).

10 If you exit from the external effect mode, call up the Control Panel then select an item other than “External FX” in the “Digital I/O, External FX” column.
Dedicated windows for the MR816 CSX/MR816 X in Cubase

If both “TOOLS for MR” and Cubase have been installed to your computer, dedicated windows for the Link functions between the MR816 CSX/MR816 X and Cubase are available in Cubase, as described here.

**MR816 CSX/MR816 X Input Settings window**

This window lets you make various settings for the internal mixer of the MR816 CSX/MR816 X. From this window, you can set almost all the parameters related to the input channels of the MR816 CSX/MR816 X, such as phase, high pass filter on/off, Channel Strip, and REV-X.

### How to call up the window

Follow the instructions below.

#### For Cubase

1. Select [Devices] → [Mixer] to call up the Mixer window.
2. Click the arrow ( показывает равенство ) button (“Show Extended View”) to call up the Extended Mixer.
3. Click the triangular ( показывает равенство ) button (“Extended View Type/Can Hide State”) of the desired input channel then select “Hardware” from the menu.

#### For Cubase AI

1. Click the Edit ( показывает равенство ) button (“Edit Channel Settings”) of the desired audio channel to call up the VST Audio Channel Settings window.
2. Right-click any location on the VST Audio Channel Settings window (Mac: click while holding the Control key) then select [Customize View] → [Input Hardware] from the pop-up menu.

**NOTE**

- You can call up the MR816 CSX/MR816 X Input Settings window also via the following operation. Click the Edit ( показывает равенство ) button (“Edit Input Channel Settings”) to call up the VST Input Channel Settings window. Right-Click any location on the window then select [Customize View] → [Hardware] from the pop-up menu.

- The settings made in the MR816 CSX/MR816 X Input Settings window will be saved as a project file of Cubase. This means that you can recall the previously-created settings as soon as you open the Project file the next time.
- When the MR816 CSX/MR816 X is set to the external effect mode, the parameters related to the Channel Strip and REV-X will be set on the VST plug-in effect setup window. This means that these parameters will not be shown on the MR816 CSX/MR816 X Input Settings window.
Parameter functions

1. +48V / PAD indicator (indication only)
   This section indicates the on/off status of the phantom power and PAD for each of the analog input channels 1 – 8.

2. High pass filter (HPF)
   Click this to turn the High Pass Filter on or off. When the High Pass Filter is turned on, signals below 80 Hz (which are very low frequency components) are reduced.

3. Phase
   Click this to invert the phase of each input channel’s signal.

   **NOTE**
   • The Input Phase button located above the MR816 CSX/MR816 X Input Settings window is not available when Direct Monitoring is turned on.

4. Channel Strip Edit (only for MR816 CSX)
   Click this to call up the window for editing the parameters of the Sweet Spot Morphing Channel Strip effect. For details, refer to page 27.

   **NOTE**
   • The Channel Strip can be applied to either the analog input channels or the digital input channels of the MR816 CSX. Accordingly, the Channel Strip related parameters (0 – 3) are not available for analog input channels when the Channel Strip is applied to the digital input channels. You can select analog or digital by setting the Sweet Spot Morphing Ch. Strip parameter (page 32) on the Control Panel.

5. DRIVE (only for MR816 CSX)
   Adjusts the degree to which the compressor is applied (page 29). The higher the value the greater the effect.

6. MORPH (only for MR816 CSX)
   Adjusts the Channel Strip Sweet Spot Data (page 28). Specific, pre-programmed compressor and equalizer settings are assigned to each of several points of this knob, letting you morph the selected Sweet Spot data by rotating this knob.

7. Effect Insertion location (only for MR816 CSX)
   Determines the location to which the Channel Strip effect is to be inserted. According to the setting here, the graphic on the window will change to indicate the actual signal flow. You can select the desired one from the following items by dragging and moving the black circle.

8. Output position of the Direct Monitoring signal (indication only)
   Indicates the position from which the audio signals for monitoring will be output when the Direct Monitoring is available.

9. REV-X Edit (only for MR816 CSX)
   Click this to open the setup window (page 25) for setting the REV-X parameters.

10. REV-X Send
    Adjusts the level of the input channel’s signal which is to be sent to the REV-X (i.e. reverb depth).

11. REV-X Setup
    Click this to call up the Reverb Routing page of the MR816 CSX/MR816 X Hardware Setup window (page 23). From this window, you can select the channel whose audio signal is sent to the REV-X and adjust the REV-X Reverb Time and Return Level.

12. Headphone Setup
    Click this to call up the Headphones page of the MR816 CSX/MR816 X Hardware Setup window (page 23). From this window, you can select the signal source output from headphone jacks 1 and 2, and adjust the output level.
MR816 CSX/MR816 X Hardware Setup window

From this window, you can make the settings related to the output signal of the headphone jacks, reverb (REV-X), master levels, and routing. This window consists of four pages which can be called up via each of four tabs at the top of the window.

NOTE
• The settings made in the MR816 CSX/MR816 X Hardware Setup window will be saved as a project file of Cubase, with the exception of the headphone’s output level. This means that you can recall the previously-created settings as soon as you open the Project file the next time.

■ How to call up the window

Follow the instructions below.

For Cubase
• Click “Headphone Setup” or “REV-X Setup” on the MR816 CSX/MR816 X Input Settings window (page 21).
• Select [Devices] → [Audio Hardware Setup].

For Cubase AI
• Select [Devices] → [Audio Hardware Setup].

■ Parameter functions

When the Headphones tab is selected:

When the Master Levels tab is selected:

When the Reverb Routing tab is selected:

When the Settings tab is selected:
Dedicated windows for the MR816 CSX/MR816 X in Cubase

1 Headphones/Reverb Routing/Master Levels/Settings tab
   Calls up the desired page by clicking the respective tab. On the Headphone page, you can make the settings related to the headphones. On the Reverb Routing page, you can set parameters such as effect type and return level of the REV-X. On the Master Levels page, you can adjust the master level. On the Settings page, you can determine which jack is used for input/output of the digital audio signal, or determine the channels to which the Sweet Spot Morphing Channel Strip effect is inserted.

2 1/2/3 tab (only when two or more devices are connected)
   Determines the device to be controlled from among two or three devices (MR816 CSX/MR816 X) which are connected to a computer in daisy-chain fashion. These tabs are available only when two or three devices are connected.

3 Monitor source (Headphone jack 1)
   Determines the source of the signal output from the headphone jack 1. When using Cubase, you can output the mix sound for monitoring by selecting the mix created via the Control Room function as the monitor source.

   NOTE
   • When using Cubase AI, you can assign the monitor source to the headphone jack by selecting one of the specific stereo output buses set in the VST Connection window.

4 Monitor volume (Headphone jack 1)
   Determines the output level of headphone jack 1.

5 Monitor source (Headphone jack 2)
   Determines the source of the signal output from headphone jack 2.

6 Monitor volume (Headphone jack 2)
   Determines the output level of headphone jack 2.

   NOTE
   • When two or three devices (MR816 CSX/MR816 X) are connected to a computer in daisy-chain fashion, the number is assigned to the devices in the order they are recognized by the computer. Each number assigned to each device corresponds to the 1, 2, or 3 tab. For details, refer to page 43.

7 Reverb type
   Determines the reverb type (Hall/Room/Plate) of the REV-X.

8 Reverb time
   Determines the reverb time of the REV-X.

9 Checkbox for selecting the channel whose the signal is transferred to the REV-X
   Determines the channel of the audio signal which is to be transferred to the REV-X. You can select the channel by clicking this field so that the checkmark is entered.

10 Return Level settings
    Indicates the Return Level settings from the REV-X for the respective channels. When using Cubase and the Control Room function is turned on, the Studio Channels are indicated here. Also the monitor channel and phone channel are indicated here if you have created them. When turning off the Control Room function or using Cubase AI, only the output buses set in the VST Connection window are indicated here.

11 Return Level
    Determines the Return Level of the REV-X for each channel as output destination. Select the channel (褐色) then drag the dial icon to adjust the return level of the REV-X for the selected channel.

12 Value of Master Level settings (analog output jacks)
   Indicates the Value of Master Level settings of the analog output jacks for the respective channels. When using Cubase and the Control Room function is turned on, the Studio Channels are indicated here. Also the monitor channel and phone channel are indicated here if you have created them. When turning off the Control Room function or using Cubase AI, only the output buses set in the VST Connection window are indicated here.

13 Master Level (analog output jacks)
   Determines the Master Level of the analog output jacks for each channel.

14 Value of Master Level settings (digital output jacks)
   Indicates the Value of Master Level settings of the digital output jacks for the respective channels. When using Cubase and the Control Room function is turned on, the Studio Channels are indicated here. Also the monitor channel and phone channel are indicated here if you have created them. When turning off the Control Room function or using Cubase AI, only the output buses set in the VST Connection window are indicated here.

15 Master Level (digital output jacks)
   Determines the Master Level of the digital output jacks for each channel.

16 [reset] button
   Sets the master level of all currently displayed channels to “0.00(dB).”

17 Digital I/O, External FX
   Determines which jack is used for input/output of the digital audio signal. For details, refer to “Digital I/O, External FX” on page 31.

18 Sweet Spot Morphing Ch. Strip
   Determines the channels to which the Sweet Spot Morphing Channel Strip effect is inserted. For details, refer to “Sweet Spot Morphing Ch. Strip” on page 32.

19 External FX Type (MR816 CSX only)
   Determines how the MR816 CSX works as an external effect unit for the DAW software. For details, refer to “External FX Type (MR816 CSX only)” on page 32.

20 Master Level Meter
   Turning this checkbox on will assign the level meter function for the master output to the LED lamps around the Multi Function Encoder knob.
REVERB-X

The REV-X effect built into the MR816 CSX/MR816 X is a complex reverb algorithm developed by Yamaha. It provides a high-density, richly reverberant sound quality, with smooth attenuation, spread and depth that work together to enhance the original sound. The MR816 CSX/MR816 X features three types of REV-X effects: Hall, Room and Plate of which the related parameters can be controlled from Cubase.

The settings related to effects will be saved as a Project file of Cubase. This means that you can recall the previously-made settings as soon as you open the Project file the next time. The REV-X parameters can be adjusted from a dedicated window in Cubase.

How to call up the window

For both Cubase and Cubase AI
Click the REV-X Edit ( ) button on the MR816 CSX/MR816 X Input Settings window (page 21).

NOTE

• This window can also be called up by setting the MR816 CSX/MR816 X to the external effect mode and using the REV-X as a VST plug-in effect of Cubase. For details, refer to “Using the built-in effect of the MR816 as a VST plug-in of Cubase” on page 19.

• Call up the REV-X Setup window from the MR Editor if you are not using Cubase.

Parameter functions

1 VST preset
This section lets you store the REV-X settings as preset data of the VST plug-in effect or call up the preset data. Click the icon ( ) at right to call up or store the data actually.

2 Graph
Indicates the characteristics of reverberation. The vertical line indicates the signal level while the horizontal line indicates the time.

3 REV-X type/parameter value
When this window is called up, this box indicates the Reverb type currently active. When clicking any of the sliders, the indication shows the corresponding parameter and its current value.

NOTE

• On Cubase, the REV-X type can be selected on the MR816 CSX/MR816 X Hardware Setup window (page 23).

4 REVERB TIME
Determines the reverb time. Higher values extend the reverberation.

<table>
<thead>
<tr>
<th>Effect Type</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>REV-X HALL</td>
<td>0.3 – 18.0 (sec)</td>
</tr>
<tr>
<td>REV-X ROOM</td>
<td>0.3 – 10.0 (sec)</td>
</tr>
<tr>
<td>REV-X PLATE</td>
<td>0.3 – 26.0 (sec)</td>
</tr>
</tbody>
</table>

5 INITIAL DELAY
Determines the time that elapses between the direct, original sound and the initial reflections (echoes) that follow it. The larger the value, the greater the delay and the longer it takes for the initial reflections to be heard.

Range: 0.1 – 200.0 (msec)

6 HPF (High Pass Filter)
Determines the cutoff frequency of the high pass filter. The high pass filter passes signals only above the specified cutoff frequency.

Range: 20 Hz – 8.0 kHz
LPF (Low Pass Filter)
Determines the cutoff frequency of the low pass filter. The low pass filter passes signals only below the specified cutoff frequency.

Range: 1.0 kHz – 20.0 kHz

DIFFUSION
Determines the spread of the reverberation. The higher the value, the greater the spread.

Range: 0 – 10

ROOM SIZE
Determines the size of the simulated room. The higher the value, the greater the room size.

Range: 0 – 31

HIGH RATIO
Determines the duration of reverberation in the high frequency range by using a ratio relative to the REVERB TIME parameter. When this parameter is set to 1, the REVERB TIME setting is actually applied to the sound. The lower the value, the shorter the duration of reverberation in the high frequency range.

Range: 0.1 – 1.0

LOW RATIO
Determines the duration of reverberation in the low frequency range by using a ratio relative to the REVERB TIME parameter. When this parameter is set to 1, the REVERB TIME setting is actually applied to the sound. The lower the value, the shorter the duration of reverberation in the low frequency range.

Range: 0.1 – 1.4

DECAY
Determines the characteristic of the envelope from the moment the reverberation starts to the moment it attenuates and stops.

Range: 0 – 63

MIX
This parameter determines the mix balance between the reverberation produced by the REV-X and the original input sound as expressed in a ratio. The higher the value, the higher the ratio of reverberation to the original sound. This parameter should be set to “100.0%” when the REV-X is used as Send/Return while this parameter should be adjusted when the REV-X is inserted to a specific channel. You can view this parameter only by setting the “Digital I/O External FX” parameter to “External FX” on the Control Panel (page 30) or the MR Editor (page 41), using the REV-X as a VST plug-in effect (page 19).

Range: 0.0% – 100.0%
Sweet Spot Morphing Channel Strip (MR816 CSX only)

This effect has been developed by using Yamaha’s Sweet Spot Morphing Technology. This technology lets you simply rotate the knob to adjust compressor and equalizer effects and easily call up appropriate, professional-level settings that would otherwise be difficult for recording novices to discover. As illustrated below, the entire system consists of a compressor (with the side chain filter) and a 3-band equalizer, which is applied to 8 mono input channels (4 stereo input channels) of the MR816 CSX. The parameters for this effect can be adjusted from a dedicated window.

The MR816 CSX provides various preset settings of the Sweet Spot Morphing Channel Strip as “Sweet Spot data” specially created by top-class engineers. You can find the desired or professional-level sound by selecting the Sweet Spot data then rotating the DRIVE knob and MORPH knob at the center bottom of the Sweet Spot Morphing Channel Strip window-instead of having to adjust each of the parameters. Each Sweet Spot data contains several settings for the compressor and equalizer. The setting is changed gradually between them by rotating the MORPH knob, instantly and automatically changing all the related parameters according to the knob rotation. Of course, you can also adjust each of the parameters including the DRIVE knob for controlling the compressor. The effect related settings will be saved as a Project file of Cubase. This means that you can recall the effect related settings as soon as you open the Project file the next time. All the effect parameters can be adjusted from a dedicated window within Cubase.

How to call up the window

For both Cubase and Cubase AI
Click the Channel Strip Edit ( ) button on the MR816 CSX/MR816 X Input Settings window (page 21).

NOTE
- This window can also be called up by setting the MR816 CSX/MR816 X to the external effect mode and using the Channel Strip as a VST plug-in effect of Cubase. For details, refer to "Using the built-in effect of the MR816 as a VST plug-in of Cubase" on page 19.
■ Parameter functions

Parameters both for the compressor and equalizer

1 VST preset
This section lets you store the Channel Strip settings as preset data of the VST plug-in effect or call up the preset data. Click the icon at right to call up or actually store the data.

2 Sweet Spot Data
Clicking this calls up a box from which you can select the desired Sweet Spot Data which includes the compressor settings that were created by top-class engineers. You can create your favorite sound simply by rotating the MORPH knob to “morph” the selected Sweet Spot Data according to your taste.

From this box, select the desired Sweet Spot Data then click [OK] to actually load the settings. For information about the available data, refer to the following page:
http://service.steinberg.de/goto.nsf/show/supportupdates_mr816_gb/

3 MORPH knob
Rotating this knob will morph the selected Sweet Spot Data. The preset setup of the compressor and equalizer is assigned to each of several locations in the knob. The different setting will be called up automatically according to the knob's pointer location.

Parameters for the compressor

4 Compressor curve (indication only)
This mini-graph indicates the approximate compressor response for the current input channel. The horizontal line indicates the input signal level while the vertical line indicates the output signal level. The compressor is not applied to the range within the linear, proportional response (output level is equivalent to input level), whereas it is applied to the range where the response curve is flatter (the more flat the slope or declination, the higher the compression ratio). Controlling the DRIVE knob determines the threshold level (above which the compressor is applied) indicated as the turning point of this graph.

5 GR meter
Indicates the gain reduction (or GR, which is the amount over which the actual level is reduced by compression) in real time.

6 ATTACK
Adjusts the attack time of the compressor (the time from when the signal exceeds the threshold level until compression begins). The larger the value, the longer the time until compression actually begins.

Range: 0.092 – 80.00 (msec)

7 RELEASE
Adjusts the release time of the compressor (the time from when the signal falls below the threshold level until compression is removed). The larger the value, the longer the release time.

Range: 9.3 – 999.0 (msec)
Dedicated windows for the MR816 CSX/MR816 X in Cubase

**RATIO**
Adjusts the compression ratio (the ratio at which the input signal will be compressed when the signal exceeds the threshold level). The larger the value, the higher the ratio.

| Range: | 1.00 – ∞ |

**KNEE**
Selects the sharpness at which the output level changes around the threshold level. The HARD setting produces the sharpest change while the SOFT setting produces the most gradual change.

| Settings: | SOFT, MEDIUM, HARD |

**SIDE CHAIN Q**
Adjusts the band width of the side chain filter (peaking filter) used for adjusting the frequency range to which the compressor is applied. By setting the Q (band width), F (center frequency) and G (gain) parameters of the side chain filter, you can adjust how much compression is applied to the specified frequency range.

| Range: | 0.50 – 16.00 |

**SIDE CHAIN F**
Adjusts the center frequency of the side chain filter as the band pass filter.

| Range: | 20.0Hz – 20.0kHz |

**SIDE CHAIN G**
Adjusts the gain of the side chain filter as the band pass filter.

| Range: | -18.0dB – 18.0dB |

**DRIVE knob**
Adjusts the amount of compression applied to the current channel. The higher the value, the stronger the effect.

| Range: | 0.00 – 10.00 |

**COMPRESSOR on/off**
Turns the compressor on or off. When the COMPRESSOR is turned off (dimmed), parameter editing is not available.

| Range: | OFF/ON |

**Parameters for the equalizer**

**Equalizer curve**
This mini-graph indicates the characteristics of the 3-band equalizer for the current input channel. The shape of this graph is determined by setting the parameters listed below this graph, rotating the MORPH knob, or dragging and moving the graph directly.

**Level meter**
Indicates the level output from the equalizer unit in real time.

**LOW F**
Adjusts the center frequency of the low band.

| Range: | 20.0Hz – 1.00kHz |

**LOW G**
Adjusts the gain of the low band.

| Range: | -18.0dB – 18.0dB |

**MID Q**
Adjusts the band width of the middle band.

| Range: | 0.50 – 16.00 |

**MID F**
Adjusts the center frequency of the middle band.

| Range: | 20.0Hz – 20.0kHz |

**MID G**
Adjusts the gain of the middle band.

| Range: | -18.0dB – 18.0dB |

**HIGH F**
Adjusts the center frequency of the high band.

| Range: | 500.0Hz – 20.0kHz |

**HIGH G**
Adjusts the gain of the high band.

| Range: | -18.0dB – 18.0dB |

**EQUALIZER on/off**
Turns the equalizer on or off. When the EQUALIZER is turned off, equalization is not applied to the input signal of the current channel.

**TOTAL GAIN**
Boosts or reduces the total gain of the Sweet Spot Morphing Channel Strip effect. The higher the value, the larger the gain.

| Range: | -18.0dB – 18.0dB |

**NOTE**
- The TOTAL GAIN parameter is not available when both the compressor and equalizer are turned off.
**Control Panel**

This window lets you set basic parameters such as the Word Clock source and Sample Rate of the MR816 CSX/MR816 X. The Control Panel consists of the General window, MR816 CSX/MR816 X window and About window which lets you set the parameters such as sampling rate and word clock source. The settings here are immediately applied to the MR816 CSX/MR816 X.

### How to call up the window

**Windows:**
- From the Device filed on the Device Setup window (called up via [Devices] → [Device Setup...]) of Cubase, select “Yamaha Steinberg FW ASIO” then click “Control Panel” button.
- Double-click the driver icon indicated on the Taskbar Notification area, or right-click the icon, then select “Control Panel.”
- Select [Start] → [Control Panel] → [Yamaha Steinberg FW Driver].

**Mac:**
- From the Device field on the Device Setup window (called up via [Devices] → [Device Setup...]) of Cubase, select “Yamaha Steinberg FW” and click the “Control Panel” button. Then click the “Open Config App” button on the CoreAudio Device Settings window.
- Select [System Preferences] → [Yamaha Steinberg FW].
- Select “Yamaha Steinberg FW” on the Audio Devices window (called up via [Applications] → [Utilities] → [Audio MIDI Setup]), and select “Configure device...” in the Action menu (gearwheel icon) at the left bottom of the window.

**NOTE**
- The explanations below use Windows are an example, but the basic operation is the same for both Windows and Mac.

### Parameter functions

**Overall**

- **Tab**
  - Calls up the corresponding window. To close the Control Panel window, click the “X” at the top right corner of the window on Windows, or click the “X” at the top left corner of the window on Mac.

**NOTE**
- When two or three MR816 CSX/MR816 Xs are connected in daisy-chain fashion, the corresponding tabs are indicated with the number assigned to each device. For details, refer to page 43.

**General window**

1. **Sample Rate**
   - Specifies the sample rate of the MR816 CSX/MR816 X from 44.1 kHz, 48kHz, 88.2kHz and 96kHz.

2. **WORD CLOCK Master**
   - Selects the master device of the Word Clock. This parameter is available only when two or three MR816 CSX/MR816 Xs are connected in daisy-chain fashion.
3 Clock Source
Selects the Word Clock source of the current MR816 CSX/MR816 X. Word Clock source values that cannot be synchronized to the MR816 CSX/MR816 X are indicated in italics.

<table>
<thead>
<tr>
<th>Internal</th>
<th>When this is selected, the internal word clock will be used, meaning that the current MR816 CSX/MR816 X works as the master device.</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADAT</td>
<td>When this is selected, the word clock input signal of ADAT format from the OPTICAL IN jack will be used as the Word Clock source. This value is available only when the Digital I/O, External FX is set to “ADAT (1-4) + S/PDIF (coax)” (if the Sample Rate is set to 88.2/96 kHz) or “ADAT (1-6) + S/PDIF (coax)” (if the Sample Rate is set to 44.1/48 kHz).</td>
</tr>
<tr>
<td>S/PDIF (opt)</td>
<td>When this is selected, the word clock input signal of the S/PDIF format from the OPTICAL IN jack will be used as the Word Clock source. This value is available only when the Digital I/O, External FX is set to “S/PDIF (opt) + S/PDIF (coax)”</td>
</tr>
<tr>
<td>S/PDIF (coax)</td>
<td>When this is selected, the word clock input signal from the S/PDIF IN jack will be used as the Word Clock source. This value is available only when the Digital I/O, External FX is set to “ADAT (1-4) + S/PDIF (coax)” (if the Sample Rate is set to 88.2/96 kHz) or “ADAT (1-6) + S/PDIF (coax)” (if the Sample Rate is set to 44.1/48 kHz).</td>
</tr>
<tr>
<td>WCLK In</td>
<td>When this is selected, the word clock input signal from the WCLK IN jack will be used as the Word Clock source.</td>
</tr>
</tbody>
</table>

NOTE
- When the Word Clock Source is set to a value other than “Internal,” make sure to set the Sample Rate (page 30) of the MR816 CSX/MR816 X to the same value as that of the clock master device.

4 ASIO Buffer Size (Windows only)
Determines the buffer size for the ASIO driver.

5 Input Latency/Output Latency (Windows only)
Indicates the delay time for the audio input/output in milli-second units. Audio latency differs depending on the value of the ASIO Buffer Size. The lower the value of the ASIO Buffer Size, the lower the value of Audio Latency.

6 Enable MMCSS (Windows only)
Determines whether the MMCSS (Multimedia Class Scheduler Service) is active or not. If you place a checkmark in the checkbox, MMCSS will be enabled and driver performance will be improved.

NOTE
- Depending on the application, noise may occur when MMCSS is active. In this case, remove the checkmark in order to disable MMCSS.

7 Audio Routing (Windows only)
Click this to call up the WDM Audio Routing window. From this window, you can determine the input/output jack used for the WDM Audio driver. In each section, the upper box selects the device (only when two or three MR816 CSX/MR816 Xs are connected in daisy-chain fashion) and the lower box selects the input or output jacks.

NOTE
- This parameter specifies which jacks accept the input signals sent to a computer and to which jacks the output signals from the computer are sent. The input channels are stereo channels. The output channels are six consecutive channels from the stereo channels set in the output port setting.
- The port name (device name) of the WDM Audio driver is “Yamaha Steinberg FW WDM Audio.”

8 Place Icon In the taskbar (Windows only)
When this checkmark is entered, the driver icon is indicated on the Taskbar Notification area.

9 Reset Device Number
Clicking this resets the indication order of the devices on the DAW software. This operation is only effective when two or more MR816 CSX/MR816 Xs are connected in daisy-chain fashion. For details about daisy-chain connections, refer to page 43.

MR816 CSX/MR816 X window

1 Firmware Version
Indicates the firmware version of the MR816 CSX/MR816 X. Clicking [Check for Updates] will call up the website from which you can download the latest firmware program.

2 Digital I/O, External FX
Determines which jack (S/PDIF, OPTICAL or both) is used for input/output of the digital audio signal.

<table>
<thead>
<tr>
<th>ADAT</th>
<th>When this is selected, the ADAT format signal of 8 channels will be input/output via the OPTICAL IN/OUT jacks.</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADAT (1-6) + S/PDIF (coax) or ADAT (1-4) + S/PDIF (coax)</td>
<td>When this is selected, the ADAT format signal of 6 channels (when the Sample Rate is set to 44.1kHz or 48 kHz) or 4 channels (when the Sample Rate is set to 88.2 kHz or 96kHz) will be input/output via the OPTICAL IN/OUT jack. Furthermore, the S/PDIF format signal of 2 channels will be input/output via the S/PDIF IN/OUT jack in stereo.</td>
</tr>
<tr>
<td>S/PDIF (opt) + S/PDIF (coax)</td>
<td>When this is selected, the S/PDIF format signals of 2 channels will be input/output via the OPTICAL IN/OUT jack and the S/PDIF format signals of 2 channels will be input/output via the S/PDIF IN/OUT jack.</td>
</tr>
<tr>
<td>External FX</td>
<td>When this is selected, the MR816 CSX/MR816 X is set to the External Effect mode. For details about the External Effect mode, refer to page 19.</td>
</tr>
</tbody>
</table>
NOTE

- If audio signals that cannot be synchronized with the Word Clock Source are sent to the MR816 CSX/MR816 X, the Word Clock Source lamps flash. In this state, make sure to send appropriate audio signals to the jack specified as the Word Clock Source. Alternately, change the Word Clock Source to a different value so that synchronization is possible.
- When the “Digital I/O, External FX” parameter is set to “S/PDIF (opt) + S/PDIF (coax)” and the “Clock Source” (page 31) parameter is set to “S/PDIF (opt)” or “S/PDIF (coax),” sending audio signals that cannot be synchronized (such as different data format or unstable sample rate) to the jack specified as the Word Clock Source results in both the OPTICAL IN jack and S/PDIF IN jack being unable to accept any audio signals.
- When the “Digital I/O, External FX” (page 31) parameter is set to “External FX,” the “Clock Source” (page 31) parameter can be set to only “Internal” or “WCLK In.” If the “Clock Source” (page 31) parameter has been set to something other than “Internal” and “WCLK In,” the parameter will be automatically set to “Internal” in that case.

3 Sweet Spot Morphing Ch. Strip

Determines the channels to which the Sweet Spot Morphing Channel Strip effect is inserted.

| Mic/Line Input | When this is selected, the Sweet Spot Morphing Channel Strip effect is inserted to the analog input channels. |
| Digital Input  | When this is selected, the Sweet Spot Morphing Channel Strip effect is inserted to the digital input channels. |

4 External FX Type (MR816 CSX only)

By setting this parameter, you can determine how the MR816 CSX works as an external effect unit for the DAW software. This parameter is available only when the Digital I/O, External FX parameter (page 31) is set to “External FX,” or in other words, when the MR816 CSX is set to the External Effect mode. When using the MR816 X, this parameter is not available since only the REV-X is built into the MR816 X.

| 8 x Mono | When this is selected, the Sweet Spot Morphing Channel Strip effect of 8 mono channels can be used. |
| 4 x Stereo | When this is selected, the Sweet Spot Morphing Channel Strip effect of 4 stereo channels can be used. |
| 6 x Mono + REV-X | When this is selected, the Sweet Spot Morphing Channel Strip effect of 6 mono channels and the REV-X effect (stereo) can be used. |
| 3 x Stereo + REV-X | When this is selected, the Sweet Spot Morphing Channel Strip effect of 3 stereo channels and the REV-X effect (stereo) can be used. |

5 Identify

Clicking this will flash the lamps of the Multi Function Encoder knob on the front panel of the MR816 CSX/MR816 X which is currently being controlled from a computer. This operation lets you confirm which device is actually controlled from a computer when two or more devices are daisy-chain connected.
The included MR Editor (see the “Getting Started” printed manual) gives you versatile tools for mixing the audio signal inputs of the MR816 CSX/MR816 X.

**IMPORTANT**
The MR Editor is used when you use a DAW other than Cubase or you want to set the necessary settings for using the MR816 CSX/MR816 X without connecting a computer. Note that Cubase and the MR Editor cannot be active simultaneously because Cubase controls the mixing parameters of the MR816 CSX/MR816 X.

On the MR Editor, the mixing operation for each output can be performed by selecting the output at the right end in the main window then setting the parameters such as volume and pan for each of 16 input channels in the Mixer section. For monitoring the mixed sound, up to two outputs can be heard from the headphone jacks 1 and 2 simply by clicking the headphone icon (page 14) after selecting the desired output. The settings made on the MR Editor will be stored (overwritten) to internal memory in the MR816 CSX/MR816 X automatically by executing the Scene Store operation, and will be maintained even if the power is turned off. Turning the power on the next time will transfer the settings on the MR816 CSX/MR816 X to the MR Editor on the computer automatically. Even when two or three MR816 CSX/MR816 Xs are connected to the computer in daisy-chain fashion, the MR Editor can control them individually.

The MR Editor can be called up via the following operations.

**Windows:**
- Select [All Programs] → [Steinberg MR] → [MR Editor]
- From the driver icon indicated on the Taskbar Notification area, right-click this icon then select “MR Editor.”

**Mac:**
- [Applications] → Double-click [MREditor]

The MR Editor consists of the Main window and Setup window. The explanations below cover the functions of these windows.

### Main window
The Main window lets you adjust various parameters such as mixing and internal effects (REV-X and Sweet Spot Morphing Channel Strip) related parameters for the input signal from the external audio device and computer. The input signals mixed with the controls in the center of the window are output from the output channels specified at the right of the window. Note that the External Effect mode is available when using the MR Editor as well as Cubase. You can set the MR816 CSX/MR816 X to the External Effect on the MR Editor.

To close the MR Editor window, click the [X] button at the top left corner.

#### Main window in the Normal mode:
Main window for “EXT FX” in the External Effect mode:

* The window above can be viewed when using the MR816 CSX and the “External FX Type” (page 41) is set to “6 x Mono + REV-X” in the Setup window or the Control Panel of the Yamaha FW Driver window.

**NOTE**
- For information about the External Effect mode, refer to page 19.
- You can set the MR816 CSX/MR816 X to External Effect mode or Normal mode from the Setup window (page 41) on the MR Editor or Control Panel (page 30).
Scene section

Up to 20 mixer settings created on the MR Editor can be stored as scenes and these 20 scenes (mixer settings) can be saved as a single file to a computer. The current scene or settings are applied to the MR816 CSX/MR816 X in real time.

File icon

Click this to call up the menus: “Open,” “Save” and “Import Scene.”

Open
Opens an MR Editor file (extension: MRE).

Save
Saves all the Scenes and current settings as an MR Editor file (extension: MRE).

Import Scene
Imports only the desired Scene from the specified MR Editor file (extension: MRE). From the IMPORT SCENE window called up by selecting this menu, select the desired file (at the file icon) and desired Scene as source in the left column then select the destination Scene number in the right column. Clicking [OK] at right in the window will actually perform the Import operation, while clicking [CANCEL] or [X] at the left top corner will abort the Import operation.

Initialize All Scenes
Deletes all the scenes which have been stored to the MR Editor. Click this menu to call up the confirmation dialog then click [YES] to actually delete all the scenes. When two or three MR816 CSX/MR816 Xs are connected in daisy-chain fashion, all the scenes for the MR816 CSX/MR816 X are specified at the DEVICE section.

Scene name

Indicates the current Scene number and Scene name. If you want to change the name of the current Scene, click the Scene name then edit it. When the Scene 0 or a Scene having no data is selected, clicking the Scene name calls up the Scene list, meaning that the name cannot be edited. If you want to call up a different Scene, click the triangular pointer at the right of the Scene name to call up the Scene list then select the desired Scene. Clicking the selected Scene will change the current settings in the Input Mixer section to the corresponding ones.

NOTE
- The Scene number 0 includes the default initial settings.
- The Scene named “---” contains no data.
- You can call up the Scene list also by clicking the triangular indication at right of the Scene name box.

STORE

Click this to call up the STORE window. From this window, the current mixer settings can be stored as a Scene. This operation will also store the settings to internal memory of the MR816 CSX/MR816 X.

Double-click the NAME box, edit the Scene name, select the destination number then click [OK] to store the current settings to the selected number as a Scene. Click [CANCEL] or [X] at the left top corner to abort the Store operation.

NOTE
- Scene number 0 cannot be overwritten since it contains the initial default settings.
- When storing a Scene, only the settings for the specific device specified in the DEVICE section will be stored. When two or three MR816 CSX/MR816 Xs are connected, you will need to store the settings for each device separately.

DEVICE section

This section lets you select the device for which the settings will be edited. This section indicates icons of all the connected MR816 CSX/MR816 X devices.

Device icon

Select the desired device icon from the ones indicated here. The Multi Function Encoder knob lamps of the MR816 CSX or MR816 X specified here will flash briefly.

NOTE
- For information about settings when daisy-chain connecting two or three MR816 CSX/MR816 Xs and using them simultaneously, refer to page 43.
- If synchronization of the word clock fails when the Word Clock Source is set to that other than “Internal,” this device icon will flash. If this occurs, confirm whether or not the Word Clock Source setting is proper.
VIEW section

This section lets you change the view format of the Mixer section.

1 Analog icon
Click this to alternately display and hide the analog input strips.

2 Digital icon
Click this to alternately display and hide the digital input strips.

SETUP section

This section lets you call up the Setup window, Version information window and Help window.

1 SETUP
Calls up the Setup window (page 41).

2 ABOUT
Calls up the Version information window.

3 HELP
Calls up the Operation Manual PDF (this manual).

Input Mixer section

This section lets you adjust various mixing parameters such as the volume, pan and effect send level of the audio signal input via the analog/input jacks for each input channel. The mixing parameters will be set for each output channel which can be selected at the right end of the main window.

1 Channel link
Click this to link the adjacent two channels to the one stereo channel. Click this again to cancel the link. When this link is set to on, all the parameters of L and R other than pan (9) and phase (10) are linked.

2 Input jack icon
Indicates the Input jack corresponding to the input channel.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Mic" /></td>
<td>This type of icon corresponds to the MIC/LINE/Hi-Z jack on the front panel, MIC/LINE jack on the front panel and the MIC/LINE INPUT jacks 3 – 8 on the rear panel. The strip below this icon corresponds to analog input channels 1 – 8.</td>
</tr>
</tbody>
</table>
| ![ADAT](image) | This type of icon corresponds to the ADAT (OPTICAL) IN jack on the rear panel. The strip below this icon corresponds to the digital input channel. The amount of channels differs depending on the digital audio format.  
**ADAT format:** Maximum mono input channel x 8  
**S/PDIF format:** Stereo input channel x 1 |
| ![S/PDIF](image) | This type of icon corresponds to the S/PDIF IN jack on the rear panel. The strip below this icon corresponds to the stereo digital input channel. |
3. +48V, PAD (MIC 1 – 8 only) and level meter
   This section indicates information for the corresponding input channel:
   - **+48V**: On/off status of phantom power (page 5).
   - **PAD**: On/off status of the PAD (page 5).
   The level meter indicates the volume level in real time.

4. Phase (MIC 1 – 8 only)
   Click this to invert the phase of each channel’s signal.

5. High Pass Filter (MIC 1 – 8 only)
   Click this to turn the High Pass Filter on or off. When the High Pass Filter is turned on, signals below 80 Hz (which are very low frequency components) are reduced.

6. Channel Strip Edit (MR816 CSX only)
   Click this to call up the window for editing the parameters of the Sweet Spot Morphing Channel Strip effect. All of the parameters on this window are the same as those of the window (page 27) called up from Cubase, with the exception of the file icon and input channel setting (see below).

7. DRIVE knob (MR816 CSX only)
   Equivalent to the DRIVE knob (page 29) in the Sweet Spot Morphing Channel Strip window.

8. MORPH knob (MR816 CSX only)
   Equivalent to the MORPH knob (page 28) in the Sweet Spot Morphing Channel Strip window.

9. Effect insertion (MR816 CSX only)
   Selects the destination sound to which the Sweet Spot Morphing Channel Strip effect is applied. Click this to call up the pop-up menu then select the desired setting.

10. REV-X Send Level
    Adjusts the level of the input channel signal sent to the REV-X (i.e., determines how much reverb will be applied). Note that the REV-X setting is applied to the signal to which the mute, volume and pan settings of the input channel are already applied. The settings are available only for the output channel for which the REV-X SEND icon (at the Master/Headphone section) is turned on. Regarding the signal (indicated as a computer icon) coming from the DAW, the settings of this parameter are available for all the output channels.

   **NOTE**
   - The Return Level from the REV-X can be adjusted for each output channel. For details, refer to page 39.

11. Pan/Balance
    When the channel link ( ) is set to off, this control determines the stereo position of the mono input channel. Rotate the knob clockwise to pan the signal right, and counter-clockwise to pan left.
    When the channel link ( ) is set to on, this control determines the volume balance between the left and right stereo channels. Odd channel signals are fed to the L bus, and even channel signals are fed to the R bus.

12. Mute
    Turns mute on/off for each channel.

   **NOTE**
   - You can turn a specific input channel's mute on/off for all the output channels simultaneously by clicking the mute ( ) icon of the desired input channel while holding the [Alt] key or [option] key on the computer keyboard.
Solo

Turns solo on/off for each channel.

**NOTE**

- You can turn a specific input channel’s solo on/off for all the output channels simultaneously by clicking the solo ( ) icon of the desired input channel while holding the [Alt] key or [option] key on the computer keyboard. You can turn a specific input channel’s solo off for all the output channels simultaneously by clicking the solo ( ) icon of the desired input channel while holding the [Alt] key and [Ctrl] key simultaneously or holding the [option] key and [command] key simultaneously.

Fader

Adjusts the volume level for each channel.

Effect Control section

When the MR816 CSX/MR816 X is set to External Effect mode, clicking [EXT FX] at the Output section of the main window will call up the dedicated effect window shown on page 25, page 27. From that window, you can edit the parameters of the effect unit inserted to an audio track of the DAW software. This explanation covers the Effect Control section in that window.

**NOTE**

- For details on the External Effect mode, refer to page 19.
- To enable the External Effect mode, the “Digital I/O, External FX” parameter should be set to “External FX” in the Setup window, page 41, or the Control Panel of the Yamaha FW Driver window, page 30.
- While the MR816 CSX/MR816 X is set to External Effect mode, you cannot use the internal effect for input signals other than the input signal coming from the DAW software.

---

1. Channel Strip Edit (MR816 CSX only)

   Click this to call up the window for editing the parameters of the Sweet Spot Morphing Channel Strip effect. Each of the parameters on this window is equivalent to that of the Channel Strip Edit (page 37) of the Input Mixer section.

2. DRIVE knob (MR816 CSX only)

   Equivalent to the DRIVE knob (page 29) in the Sweet Spot Morphing Channel Strip window.

3. MORPH knob (MR816 CSX only)

   Equivalent to the MORPH knob (page 28) in the Sweet Spot Morphing Channel Strip window.

4. REV-X Edit

   Click this to call up the window for editing the parameters of the REV-X effect. All of the parameters on this window are the same as those of the window (page 25) called up from Cubase with the exception of the file icon indicated at the top of the window on the MR Editor. The file icon lets you save or open the file.

5. Reverb type

   Selects the reverb type from “Hall,” “Room” and “Plate.”

6. TIME (Reverb time)

   Adjusts the reverb time.
Master/Headphone section

This section lets you set the overall parameters such as master volume level, the REV-X effect on/off and headphone related settings. The parameters here (except for the headphone related settings) can be set for each output which can be selected from the eight outputs at the right end of the main window.

1 Master level meter
Indicates the master volume level for the current output channel.

2 REV-X SEND
Determines whether or not the audio signals are sent to the REV-X from the currently selected output channel. Click this to turn the REV-X Send Level on or off. When this icon is turned on, the audio signals will be sent to the REV-X according to the balance specified by setting the REV-X Send Level in the Input Mixer section. Note that this icon is turned on only for the single output via last-selection priority.

NOTE
- The Return Level from the REV-X can be adjusted for each output channel.
- Regarding the signal coming from the DAW, the REV-X Send can be adjusted for each output channel.

3 REV-X Edit
Click this to call up the window for editing the parameters of the REV-X effect. All of the parameters on this window are the same as those in the window on Cubase. For details, refer to page 25.

4 Reverb type
Selects the reverb type from “Hall,” “Room” and “Plate.” This parameter can be set regardless of the currently selected output channel.

5 TIME (Reverb time)
Adjusts the reverb time. This parameter can be set regardless of the currently selected output channel.

6 RTN (Return Level)
Adjusts the return level from the REV-X effect for the current output. This parameter can be set independently for each output.

7 Master balance
This control adjusts the left and right volume balance of the stereo overall sound of the current output.

8 Headphone setting
Click this so that you can hear the mixed sound of the current output by using the headphones connected to the headphone jacks of the MR816 CSX/MR816 X. The upper icon corresponds to the headphone jack (1) while the lower icon corresponds to the headphone jack (2). You can confirm which output sound can be heard via the headphone icon (1 / 2) at the Output section at the right end of the main window.

NOTE
- This setting cannot be stored as a Scene; however, it is saved to the MR816 CSX/MR816 X automatically.

9 Headphone level
Adjusts the volume level for the headphone connected to the headphone jack of the MR816 CSX/MR816 X.

NOTE
- This setting cannot be stored as a Scene; however, it is saved to the MR816 CSX/MR816 X automatically.

10 Master mute
Switches the mute status of the overall sound for the current output.

11 Master fader
Adjusts the overall volume level for the current output.
Output section

This section lets you select the desired output for mixing. Clicking one of the outputs (tabs) will call up the settings for the selected output in the Input Mixer section. If the MR816 CSX/MR816 X is set to the External Effect mode, “EXT FX” tab will be shown in this section instead of the digital output jacks.

In the Normal mode:  

1. **OUT 1 – 2, OUT 3 – 4, OUT 5 – 6, OUT 7 – 8**
   These analog outputs correspond to the analog output jacks (OUTPUT jacks 1&2, 3&4, 5&6 and 7&8 on the rear panel).

2. **ADAT, S/PDIF**
   These are available only when the current device (indicated at the DEVICE column) is set to the Normal mode in the Setup window. These digital outputs correspond to the digital output jacks (S/PDIF jack or OPTICAL jack on the rear panel). The number of digital output channels will differ depending on the setting as to which jack (S/PDIF or OPTICAL) is used for digital input/output and (if the OPTICAL OUT jack is used) which format (S/PDIF or ADAT) is used. This setting can be performed in the Setup window (page 41).

   • **NOTE**
     The headphone icon ( ) for each output channel indicates whether or not you can hear the sound by using the headphones.

3. **EXT FX**
   This is available only when the current device (indicated at the DEVICE column) is set to the External Effect mode (page 19) in the Setup window. Selecting this tab calls up the Effect Control section containing the parameters for the Sweet Spot Morphing Channel Strip effect (MR816 CSX only) or REV-X effect, which has been inserted a DAW software track by setting the MR816 CSX/MR816 X to the External Effect mode. For information about the External Effect mode, refer to page 19.
**Setup window**

This section explains the Setup window called up by clicking the SETUP icon at the left end of the main window. From this window, you can set basic parameters such as Sample Rate and Word Clock Source of the MR816 CSX/MR816 X. To close the Setup window, press the [X] button at the top left corner.

**NOTE**

- The parameters on the Setup window can be set also in the Control Panel (page 30). This is convenient when you want to set the basic parameters without having to start the MR Editor.

### General Settings section

This section lets you set the basic parameters such as Sample Rate and Word Clock. These parameter settings are applied commonly to all the MR816 CSX/MR816 Xs connected in daisy-chain fashion.

1. **WORD CLOCK Master**
2. **Clock Source**
3. **Sample Rate**
4. **Buffer Size (Windows only)**
5. **WDM Audio Routing IN/OUT (Windows only)**

These parameters are equivalent to those in the Control Panel (page 30).

6. **WDM Audio Routing IN/OUT (Windows only)**

The IN section determines the input jack used for the WDM Audio driver while the OUT section determines the stereo output jack used for the WDM driver. In each section, the upper box selects the device (only when two or three MR816 CSX/MR816 Xs are daisy-chain connected) and the lower box selects the input or output jacks.

**NOTE**

- This parameter specifies which jacks accept the input signals sent to a computer and to which jacks the output signals from the computer are sent. The input channels are stereo channels. The output channels are six consecutive channels from the stereo channels set in the output port setting.
- The port name (device name) of the WDM Audio driver is “Yamaha Steinberg FW WDM Audio.”

### MR816 CSX Settings/MR816 X Settings section

This section lets you set the parameters unique to the connected device.

7. **Digital I/O, External FX**
8. **Sweet Spot Morphing Ch. Strip (MR816 CSX only)**
9. **External FX Type**

These parameters are equivalent to those in the Control Panel (page 30). Note that the Effect Control section (page 38) is shown on the Main window when the Digital I/O, External FX parameter is set to “External FX.”

10. **Master Level meter**

Turning this checkbox on will assign the level meter function for the master output to the LED lamps around the Multi Function Encoder knob.

11. **Version**

Indicates the firmware version of the MR816 CSX/MR816 X.
Using a DAW other than Cubase

When using a DAW software other than Cubase, you can use the MR816 CSX/MR816 X simply as an audio interface having up to 16 input/output channels. Link-related functions such as quickly routing the input channel to an audio track of Cubase (page 9) are not available, but the following additional functions are available with the use of the MR Editor.

- Producing monitor mixed sound
  The MR Editor lets you produce the mixed sound for monitoring, and it can be heard with no latency.

- Using the effects built into the MR816 CSX/MR816 X
  You can process audio signals of the DAW with the built-in effects on the MR816 CSX/MR816 X by setting the MR816 CSX/MR816 X to the External Effect mode and making the settings for the bus and channels for input/output audio signals on the DAW manually.

**NOTE**

- The settings made on the MR Editor need to be managed separately from the DAW file. If you want to manage the music data and MR816 CSX/MR816 X related settings as a single package of data or you want to take a full advantage of the MR816 CSX/MR816 X, we recommend that you use Cubase.
Using multiple MR816 CSX/MR816 Xs

Up to three MR816 CSX/MR816 Xs can be used simultaneously by connecting them in daisy-chain fashion to a computer via IEEE1394 cables. You can upgrade your music production system and add more audio input/output channels simply by adding another MR816 CSX/MR816 X. Even when multiple MR816 CSX/MR816 Xs are connected, you can set parameters such as those for digital audio input/output, Sweet Spot Morphing Channel Strip and REV-X for each device individually.

When multiple devices are daisy-chain connected to a computer, a unique number (indicated at the end of the device name) is automatically assigned to each of the devices, in the order with which the devices are connected. The number once assigned to a device will be maintained even if it is disconnected or the power is turned off. If you want to reset this number assignment, follow the instructions below.

1. Turn off the power of all the connected MR816 CSX/MR816 Xs then disconnect all the IEEE1394 cables.
2. Call up the Control Panel of the Yamaha FW Driver window then click the [General] tab.

![IEEE1394 terminal]

3. Click the [Reset Device Number] button at the bottom right corner of this window.

![Yamaha FW Driver window]

NOTE

- The [Reset Device Number] button is available only when all the connected devices are turned off. When any device is turned on, this button is dimmed and cannot be clicked.

4. Daisy-chain connect two or three MR816 CSX/MR816 Xs to the computer in the desired order.
5. Turn on the power of the first device connected directly to the computer.

Wait until the tab corresponding to the first device appears on the Control Panel of the Yamaha FW Driver window, indicating that the computer has actually recognized the first device.
6. Turn on the power of the second device that is daisy-chain connected to the first device.

The tab corresponding to the second device appears on the Control Panel of the Yamaha FW Driver window, indicating that the computer has recognized the second device. If a third device has been connected to this second device, turn the power on in the same manner. As necessary, set the Word Clock Master to the desired device.

NOTE

- Keep in mind that up to two MR816 CSX/MR816 Xs can be connected when the Sample Rate is set to 88.2kHz or 96kHz. Even if you connect an additional third device, the last recognized device (other than the device specified as the Word Clock master) connected to the computer will not be available.
- Even if multiple IEEE1394 interfaces are installed on the computer, make sure to daisy-chain connect all devices to the jacks of a single interface. This is necessary since the computer can only recognize devices connected to a specific, single IEEE1394 interface jack, and cannot recognize devices connected to different jacks of different IEEE1394 interfaces even though they are installed on the same computer.
- In addition to the MR816 CSX/MR816 X, another audio interface compatible with the Yamaha Steinberg FW Driver can be connected to an already connected device via an IEEE1394 cable. For information about devices compatible with the Yamaha Steinberg FW Driver, refer to the following URL: http://service.steinberg.de/goto.nsf/show/supportupdates_mr816_gb
Using the MR816 CSX/MR816 X without a computer

Using the MR Editor on a computer enables you to store mixing balance and other related settings to the MR816 CSX/MR816 X. This settings are available even if the power of the MR816 CSX/MR816 X is turned off and then back on again. Accordingly, you can use the MR816 CSX/MR816 X as a standalone mixer or D/A - A/D converter without the use of a computer after the necessary settings on the MR Editor or Cubase have been completed.

For instructions on using the MR Editor, refer to page 33.

**NOTE**
- Even when two or more devices are daisy-chain connected, all the connected devices can be used without the computer.
Hints when using audio data (Windows)

For optimum use of the audio functions, we recommend you make the following settings. These settings minimize possible audio problems, such as drop outs, glitches and noise.

- **Set the DMA mode (high-speed transfer mode) of the hard disk to on**
  Select [Control Panel] → [Hardware and Sound] → [Device Manager] → “IDE ATA/ATAPI controllers,” then double-click “ATA Channel 0” and open [Advanced Settings]. Check (enable) “Enable DMA” in the “Device Properties” section.

- **Set Processor Scheduling to “Background services”**
  Select [Control Panel] → [Hardware and Sound] → [System] → [Advanced system settings] in the upper left of the window → [Advanced] → [Settings] in the Performance section → [Advanced] and select the radio button to the left of “Background services” in the “Processor scheduling” section.

- **Set the Visual Effects options to “best performance”**
  Select [Control Panel] → [Hardware and Sound] → [System] → [Advanced system settings] in the upper left of the window → [Advanced] → [Settings] in the “Performance” section → [Visual Effects] and select the radio button to the left of “Adjust for best performance.”

- **Set Remote Assistance to off**
  Select [Control Panel] → [System and Security] → [System] → [Remote settings] in the upper left of the window → [Remote] and uncheck “Allow Remote Assistance connections....”

- **Disable transition effects**
  Select [Control Panel] → [Ease of Access] → [Ease of Access Center] → “Mace it easier to focus on tasks,” then check (enable) “Turn off all unnecessary animations (when possible)” in the “Adjust time limits and flashing visuals” section.

- **Disable SpeedStep™**
  Refer to “Troubleshooting” (see page 46).

- **Disconnect your computer from the Internet**
  Select [Control Panel] → [Network and Sharing Center], and disable the connection displayed.
Troubleshooting

If an error message appears:
- Refer to the Error Message List on page 49.

No sound is heard, or the sound is too faint.
Settings on the MR816 CSX/MR816 X and connections
- The connection cable from the external device may be broken.
- Make sure that a signal from an external device or the DAW is being sent to the MR816 CSX/MR816 X’s input.
- Make sure to set the volume of the connected device to appropriate levels.
- Make sure to set the gain to an appropriate level.
- Make sure to set the [+48V] button (phantom power) to on when using a condenser microphone. Refer to page 5.
- If you are connecting an electric guitar, make sure that it is connected to an input jack that supports Hi-Z, and that the [HI-Z] switch is turned on.
- Make sure that the INSERT I/O connectors are connected properly.
- Make sure to turn off the mute for each channel.
- Make sure to raise each input channel fader to an appropriate level.
- Make sure to set the volume for the headphones and master volume applied to the output jacks.
- Make sure that the speakers or headphones are connected correctly.
- Make sure that the power to your amplifier and other external devices is turned on.
- Make sure that the volume between monitor speakers is well-balanced.
- Make sure the word clock setting is correct for both the MR816 CSX/MR816 X and the external device(s).

Connection with a computer
- Confirm whether or not the lamps of the Word Clock Source and Sample Rate flash in order. Refer to “Word Clock Source lamps and Sample Rate lamps flash in order.”

Settings on a computer
- Make sure to set the volume settings within your application to appropriate levels.
- Confirm whether or not the settings in the Yamaha Steinberg FW Driver are appropriate. For details, refer to “Audio and MIDI signals fail to transfer between computer and the MR816 CSX/MR816 X.”

The sound is distorted.
Settings on the MR816 CSX/MR816 X and connections
- The connection cable from the external device may be broken.
- Make sure that audio was recorded at an appropriate level.
- If high-level signals are being input, make sure to turn the corresponding channel Pad on.
- The Drive control for the compressor may be set excessively high in the Sweet Spot Channel Strip window of the MR Editor. Set this control to an appropriate level.
- The EQ gain may be set excessively high in the Sweet Spot Channel Strip window of the MR Editor. Set this control to an appropriate level.
- The faders for input/output channels may be raised excessively. Set all faders to an appropriate level in the main window of the MR Editor.
- Confirm whether or not the Word Clock settings for both the MR816 CSX/MR816 X and the external device(s) are correct.

Settings on a computer
- Make sure that audio was recorded at an appropriate level.
- Confirm whether or not the lamps of the Word Clock Source and Sample Rate flash in order. Refer to “Word Clock Source lamps and Sample Rate lamps flash in order.”

Noise is produced.
Settings on the MR816 CSX/MR816 X and connections
- Is the master volume level of the MR816 CSX/MR816 X set too low?
  Lower the volume of the monitor speakers (powered speakers) to the minimum, then raise the master volume level of the MR816 CSX/MR816 X to high. After that, adjust the volume of the monitor speakers as desired.
- There may be a noise-inducing device (such as a device containing a power inverter, etc.) near the cables. Move all cables away from any possible sources of noise.
- Confirm whether or not the Word Clock settings on the MR816 CSX/MR816 X and the connected devices are correct.

Connection with a computer
- The IEEE1394 cable may be damaged. Cables that do not satisfy IEEE1394 (S400) standards may cause noise.
- There may be a noise-inducing device (such as a device containing a power inverter, etc.) near the IEEE1394 cables. Move all cables away from any possible sources of noise.
- Make sure that the appropriate number of devices is connected to the computer. Connection of too many devices may cause noise, depending on the capacity of the computer.

Settings on a computer
- Make sure that your computer satisfies the system requirements.
- Make sure that the latency setting of the Yamaha Steinberg FW Driver is appropriate.
- Make sure that the sample rate is appropriate. A high sample rate may be the cause of noise, depending on the computer’s capacity and speed.
- If your computer’s hard disk is slow, problems may occur during recording and playback.
- Try increasing the computer’s memory capacity.
- Quit all applications that are running in the background when you use the MR816 CSX/MR816 X (Yamaha Steinberg FW Driver) with the computer. If such software is running, driver operation may become unstable and create noise. If you do not plan to use the Yamaha Steinberg FW Driver, you can turn these applications on again.
- (For Windows) Mobile computers with Intel EIST™ (CPU SpeedStep™) technology are applied for some CPU’s (for notebook PC). If you are using the MR816 CSX/MR816 X (Yamaha Steinberg FW Driver) along with such a computer, disable the EIST™ (CPU SpeedStep™) technology function. Most computers allow you to disable/enable this in the BIOS. Please refer to the PC’s operating manual, or consult the PC manufacturer.
- (For Windows) Some network adaptors can cause noise. In such a case, use the Device Manager to disable the suspected network adaptor to remove the noise.

The computer processing speed is too slow.
- The computer’s CPU meter indicates a heavy processing load.
- Playback response is delayed.
- Insufficient tracks for recording or playback.

Connection with a computer
- Make sure that the appropriate number of devices is connected to the computer. Try reducing the number of devices connected to the computer.
Settings on a computer
• Make sure that your computer satisfies the system requirements.
• Try increasing the latency value of the Yamaha Steinberg FW Driver.
• (For Windows) Refer to “Hints when using audio data (Windows)” on page 45.

Incorrect pitch.
Settings on the MR816 CSX/MR816 X and connections
• Confirm whether or not the master device of the word clock works in a stable way.
• Make sure to set the Sample Rate of the MR816 CSX/MR816 X to the same value as that of the synchronized external audio device.

Word Clock Source lamps and Sample Rate lamps flash in order.
Settings on the MR816 CSX/MR816 X and connections
• When the lamps flash, the MR816 CSX/MR816 X may not be recognized by the connected computer. Turn off then on of the power of the corresponding MR816 CSX/MR816 X, or disconnect the IEEE1394 cable from the MR816 CSX/MR816 X then connect again.
• When multiple MR816 CSX/MR816 Xs (or devices compatible with the Yamaha Steinberg FW Driver) are daisy-chain connected, remember that up to three devices can be connected if the Sample Rate is set to 44.1kHz/48kHz and up to two devices can be connected if the Sample Rate is set to 88.2kHz/96kHz. If more devices than this limit are connected, remove unnecessary device(s) from the daisy-chain connection.
• Confirm whether or not an audio device which is not compatible with the Yamaha Steinberg FW Driver has been connected. If so, remove the corresponding device from the daisy-chain connection.
• (For Windows) Confirm whether or not the Yamaha Steinberg FW Driver or mLAN Driver/mLAN Tools is installed to the computer. If so, disable these drivers, turn the power to the corresponding MR816 CSX/MR816 X on again or disconnect the corresponding device from the computer then connect again.

The device name cannot be recognized from the DAW software.

Audio and MIDI signals fail to transfer between computer and the MR816 CSX/MR816 X.

Connection with a computer
• Confirm the status of the Word Clock Source lamps and Sample Rate lamps. If they flash in order, refer to “Word Clock Source lamps and Sample Rate lamps flash in order.”
• Make sure that the IEEE1394 cable is connected properly, and that the power to the MR816 CSX/MR816 X has been turned on. Disconnect the IEEE1394 cable once, then insert it again.
• There may be a loop connection. Check the cabling to make sure that none of the devices are connected in a loop.

Example of loop connection

- IEEE1394-equipped device

If any IEEE1394 devices which are not compatible with Yamaha Steinberg FW Driver are connected directly to a computer, disconnect them from the computer and make sure to connect only a device which is compatible with the Yamaha Steinberg FW Driver.

There may be multiple IEEE1394 interfaces installed on the computer and each of the multiple IEEE1394 devices may be connected to different interfaces. When using multiple devices compatible with the Yamaha Steinberg FW Driver and connecting them to the computer peer-to-peer individually (i.e., star-connection), make sure to connect them all to the jacks of a single interface.

Settings on a computer
• Confirm whether or not “TOOLS for MR” has been installed correctly.
• Restart the computer.
• (For Mac) If the new IEEE1394 interface (PC card, etc.) is connected to the computer (with the power turned on), restart the computer. The IEEE1394 device compatible with the Yamaha Steinberg FW Driver will be recognized by the computer after restarting.

Unable to transfer MIDI data or Program Changes.
(When using a device which is compatible with the Yamaha Steinberg FW Driver and features MIDI ports)

Settings on the device, external device and computer
• Confirm whether or not the appropriate MIDI port is selected in the application software (DAW, etc.).
• Make sure the transmission and receive channels match between both the source device and destination device including the DAW software.
• Confirm whether or not the MIDI settings have been properly made in the connected devices including the DAW.
• Confirm whether the power of all connected devices has been turned on or not.

Cannot use other connected IEEE1394 devices correctly.
• Disconnect the IEEE1394 device compatible with the Yamaha Steinberg FW Driver from the computer.

The built-in digital reverb (REV-X) is not applied to the sound.

Settings on the MR816 CSX/MR816 X
• Confirm whether or not the REV-X send level for each input channel is appropriately set.
• Confirm whether or not the REV-X return level for the entire sound is appropriately set. A setting of 0 produces no effect.
• Confirm whether or not the Reverb Time is appropriately set. If this value is too short, it may be hard to hear the reverb effect.

The Link functions for Cubase do not work.

Connection with a computer
• Make sure to properly connect the MR816 CSX/MR816 X to a computer properly.

Settings on a computer
• Make sure to install “TOOLS for MR” properly.
• Make sure to use a version of Cubase (page 9) that is compatible with the Link functions.
## Specifications

### Electrical Characteristics

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Internal</th>
<th>External</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Rate</td>
<td>44.1kHz, 48kHz, 88.2kHz, 96kHz</td>
<td>44.1kHz, 48kHz, 88.2kHz, 96kHz (± 0.1% respectively)</td>
</tr>
<tr>
<td>Total Harmonic Distortion GAIN: Minimum</td>
<td></td>
<td>0.004% or less (1 kHz @ +18 dB, into 600 Ω)</td>
</tr>
<tr>
<td>Frequency Response (CH IN to LINE OUT)</td>
<td>( f_s = 48 \text{kHz} )</td>
<td>( f_s = 48 \text{kHz} )</td>
</tr>
<tr>
<td></td>
<td>20 Hz – 20 kHz, +1, -3 dB @ +4 dB, into 600 Ω</td>
<td>20 Hz – 40 kHz, +1, -3 dB @ +4 dB, into 600 Ω</td>
</tr>
<tr>
<td>Dynamic Range (SN ratio at the maximum level)</td>
<td></td>
<td>104 dB, DA converter (LINE OUT)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>97 dB, AD + DA (to LINE OUT)</td>
</tr>
<tr>
<td>Hum &amp; Noise (20 Hz – 20 kHz)</td>
<td></td>
<td>-118 dB, Equivalent input noise</td>
</tr>
<tr>
<td></td>
<td></td>
<td>-86 dB, Residual output noise, Output fader: Minimum</td>
</tr>
<tr>
<td></td>
<td>GAIN: Maximum</td>
<td>-86 dB (90 dB SN), LINE OUT</td>
</tr>
<tr>
<td></td>
<td>PAD: OFF</td>
<td>Output channel fader: Nominal, All Input channel faders: Minimum</td>
</tr>
<tr>
<td></td>
<td>GAIN: -60 dB</td>
<td>-53 dB (57 dB SN), LINE OUT</td>
</tr>
<tr>
<td></td>
<td>PAD: OFF</td>
<td>Output channel fader: Nominal, Input channel fader (one channel): Nominal</td>
</tr>
<tr>
<td>Maximum Voltage Gain</td>
<td></td>
<td>84 dB, CH1 – 8 to LINE OUT</td>
</tr>
<tr>
<td>Crosstalk @ 1 kHz</td>
<td>GAIN: Minimum</td>
<td>-85 dB, CH1 – 8</td>
</tr>
<tr>
<td></td>
<td>Adjacent Input</td>
<td></td>
</tr>
</tbody>
</table>

### Input and Output Specifications

<table>
<thead>
<tr>
<th>Analog Input Type</th>
<th>Type</th>
<th>Input Level</th>
<th>Output Level</th>
<th>General Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIC/LINE/HI-Z jack 1,</td>
<td>XLR type balanced, +48 V Phantom powered</td>
<td>-60 dBu to +10 dBu</td>
<td>+4 dBu</td>
<td></td>
</tr>
<tr>
<td>MIC/LINE jack 2 and MIC/LINE IN jacks 3 – 8</td>
<td></td>
<td>+24 dBu</td>
<td>600 Ω</td>
<td></td>
</tr>
<tr>
<td>INSERT I/O jack 1 and 2 (INSERT IN)</td>
<td>TRS phone type, unbalanced</td>
<td>0 dBu</td>
<td>10 kΩ</td>
<td></td>
</tr>
<tr>
<td>OUTPUT jacks 1 – 8 (Line Output)</td>
<td>TRS phone type, balanced</td>
<td>+4 dBu</td>
<td>+18 dBu</td>
<td></td>
</tr>
<tr>
<td>INSERT I/O jack 1 and 2 (INSERT OUT)</td>
<td>TRS phone type, unbalanced</td>
<td>+4 dBu</td>
<td>10 kΩ</td>
<td></td>
</tr>
<tr>
<td>Headphone jacks 1 and 2 (Monitor 1/2)</td>
<td>TRS phone type, unbalanced</td>
<td>4 mW + 4 mW</td>
<td>8 Ω</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>12 mW + 12 mW</td>
<td>40 Ω</td>
<td></td>
</tr>
</tbody>
</table>

### Power Requirements
- 40W (PA-30)

### Dimensions (H x D x W)
- 44 x 305 x 480 mm

### Net Weight
- 3.2kg

### Operating Free-air Temperature Range
- +5 – +35

### Included Accessories
- AC power adaptor (PA-30 or equivalent)
- CUBASE AI DOWNLOAD INFORMATION (printed)
- CD-ROM (TOOLS for MR)
- Getting Started manual (printed booklet)
- IEEE1394 cable
- Rubber stoppers x 4
Functions

<table>
<thead>
<tr>
<th>Input Channels 1 – 8</th>
<th>Analog Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIC Preamp</td>
<td>Discrete Class-A MIC preamp (Inverted Darlington Circuitry)</td>
</tr>
<tr>
<td>[+48V] button</td>
<td>+48 V DC</td>
</tr>
<tr>
<td>[PAD] button</td>
<td>0/26 dB</td>
</tr>
<tr>
<td>Gain knob</td>
<td>44 dB variable (-60 dB to -16 dB)</td>
</tr>
<tr>
<td>Phase</td>
<td>Normal/Reversed (controlled via a computer)</td>
</tr>
<tr>
<td>High Pass Filter</td>
<td>OFF/80 Hz (-12 dB/oct.) Controlled via a computer</td>
</tr>
<tr>
<td>[HI-Z] switch</td>
<td>On/off (for channel 1), Input impedance: 500 kΩ</td>
</tr>
<tr>
<td>AD converter</td>
<td>24 bit linear, Enhanced dual-bit delta-sigma conversion</td>
</tr>
<tr>
<td>[SIG/PEAK] lamp</td>
<td>-3dB or mode (red), -40db – -3dB (green) (when the clipping point of the signal is assumed to be 0 dB)</td>
</tr>
</tbody>
</table>

Output Channels 1 – 8

<table>
<thead>
<tr>
<th>Analog Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level Control</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>DA converter</td>
</tr>
</tbody>
</table>

Headphone jacks 1 and 2

<table>
<thead>
<tr>
<th>Audio interface</th>
<th>16-ch input/16-ch output</th>
</tr>
</thead>
</table>

Error Messages

<table>
<thead>
<tr>
<th>Error message</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failed to initialize.</td>
<td>Initialization of Yamaha Steinberg FW Driver has failed.</td>
<td>Restart the computer.</td>
</tr>
<tr>
<td>(Software name) (Version) is installed. Yamaha Steinberg FW Driver cannot work with this version. Please update it to V1.6.3 or later.</td>
<td>(Windows only) The version of Yamaha n Driver, Yamaha AI Driver and mLAN Driver/mLAN Tools installed to your computer may not be compatible with the Yamaha Steinberg FW Driver.</td>
<td>Update mLAN Driver/mLAN Tools installed to your computer to V1.6.3 or later. Uninstall Yamaha AI Driver or Yamaha n Driver if necessary. (Use Yamaha Steinberg FW Driver or mLAN Driver/mLAN Tools instead).</td>
</tr>
<tr>
<td>Failed to open Control Panel.</td>
<td>The Yamaha Steinberg FW Driver does not work properly.</td>
<td>Try the following operations. • Restart the computer. • Uninstall then install TOOLS for MR.</td>
</tr>
<tr>
<td>Failed to change driver setting due to another processing.</td>
<td>The settings on the Control Panel cannot be accepted because another program is now changing the settings of the Yamaha Steinberg FW Driver.</td>
<td>Perform the settings again after a while.</td>
</tr>
<tr>
<td>Failed to change driver setting.</td>
<td>Failed due to a cause other than the above.</td>
<td>When a specific device is not recognized by the computer*: Disconnect the IEEE1394 cable from the unrecognized device then connect again or turn off the power to that device then turn on the power again.</td>
</tr>
<tr>
<td></td>
<td>Insufficient memory space.</td>
<td>When all the connected devices are not recognized by the computer*: Restart the computer.</td>
</tr>
</tbody>
</table>

European models

Purchaser/user Information specified in EN55103-1 and EN55103-2.
Inrush current: 2.0 A (MR816 CSX), 2.0 A (MR816 X)
Conforms to environments: E1, E2, E3, E4

* Specifications and descriptions in this Operation Manual are for information purposes only. Steinberg/Yamaha reserves the right to change or modify products or specifications at any time without prior notice. Since specifications, equipment or options may not be the same in every locale, please check with your Steinberg/Yamaha dealer.

Error message

<table>
<thead>
<tr>
<th>Error message</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failed to initialize.</td>
<td>Initialization of Yamaha Steinberg FW Driver has failed.</td>
<td>Restart the computer.</td>
</tr>
<tr>
<td>(Software name) (Version) is installed. Yamaha Steinberg FW Driver cannot work with this version. Please update it to V1.6.3 or later.</td>
<td>(Windows only) The version of Yamaha n Driver, Yamaha AI Driver and mLAN Driver/mLAN Tools installed to your computer may not be compatible with the Yamaha Steinberg FW Driver.</td>
<td>Update mLAN Driver/mLAN Tools installed to your computer to V1.6.3 or later. Uninstall Yamaha AI Driver or Yamaha n Driver if necessary. (Use Yamaha Steinberg FW Driver or mLAN Driver/mLAN Tools instead).</td>
</tr>
<tr>
<td>Failed to open Control Panel.</td>
<td>The Yamaha Steinberg FW Driver does not work properly.</td>
<td>Try the following operations. • Restart the computer. • Uninstall then install TOOLS for MR.</td>
</tr>
<tr>
<td>Failed to change driver setting due to another processing.</td>
<td>The settings on the Control Panel cannot be accepted because another program is now changing the settings of the Yamaha Steinberg FW Driver.</td>
<td>Perform the settings again after a while.</td>
</tr>
<tr>
<td>Failed to change driver setting.</td>
<td>Failed due to a cause other than the above.</td>
<td>When a specific device is not recognized by the computer*: Disconnect the IEEE1394 cable from the unrecognized device then connect again or turn off the power to that device then turn on the power again.</td>
</tr>
<tr>
<td></td>
<td>Insufficient memory space.</td>
<td>When all the connected devices are not recognized by the computer*: Restart the computer.</td>
</tr>
</tbody>
</table>

* The Word Clock source lamps and Sample Rate lamps flash in order when the MR816 CSX/MR816 X is not recognized by the computer.
Block Diagrams

**MR816 X**

- When setting the MR816 X to the normal mode:

  8 Analog In/Out, 8 Digital In/Out, 16 DAW In/Out
When setting the MR816 X to “External FX” (REV-X):

8 Analog In/Out, 10 DAW In/Out
MR816 CSX

- When setting the MR816 CSX to the normal mode:
  8 Analog In/Out, 8 Digital In/Out, 16 DAW In/Out
When setting the MR816 CSX to "External FX" (Sweet Spot Morphing Channel Strip):
8 Analog In/Out, 16 DAW In/Out
- When setting the MR816 CSX to “External FX” (Sweet Spot Morphing Channel Strip + REV-X):
  8 Analog In/Out, 16 DAW In/Out